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Preface
Thank you for purchasing the DocuPrint P255 d/P255 dw.
This guide is intended for users who use the printer for the first time, and provides all the necessary 
operating information about the printer.
Please read this guide to achieve the best performance from your printer.
This guide assumes you are familiar with computers and the basics of network operation and 
configuration.
After reading this guide, keep it safe and handy for future reference.

DocuPrint P255 d/P255 dw User Guide Help

Copyright© 2012 by Fuji Xerox Co., Ltd.

Fuji Xerox Co., Ltd.

July 2012 (Edition 2)

No. ME5779E2-2
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Trademarks and Document Disclaimer
Apple®, Bonjour®, ColorSync®, Macintosh®, and Mac OS® are trademarks of Apple Inc. in the United 
States and/or other countries.
PCL® is a trademark of Hewlett-Packard Corporation in the United States and/or other countries.
Microsoft®, Windows Vista®, Windows®, and Windows Server® are trademarks of 
Microsoft Corporation in the United States and/or other countries.
Linux is a registered trademark of Linus Torvalds.
Novell is a registered trademark and SUSE is a trademark of Novell, Inc. in the United States and 
other countries.
Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat, Inc. in the U.S. and 
other countries.
RSA,BSAFE are either registered trademarks or trademarks of EMC Corporation in the United States 
and/or other countries.
All product/brand names are trademarks or registered trademarks of the respective holders.

XEROX, the sphere of connectivity design, and DocuPrint are trademarks or registered trademarks of 
Xerox Corporation in the U.S. or Fuji Xerox Co., Ltd. 
DocuWorks is a trademark of Fuji Xerox Co., Ltd. 
All Xerox and Fuji Xerox product names are either registered trademarks or trademarks of Xerox 
Corporation or Fuji Xerox Co., Ltd.

In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions 
before performing the required procedures.

Fuji Xerox is not responsible for any breakdown of machines due to infection of computer virus or computer 
hacking.

IMPORTANT: 
1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied 

or modified in whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized 
operation can cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized 
operation of the equipment.

5. Decompiling this manual is prohibited.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and 
Foreign Trade of Japan and/or the export control regulations of the United States.
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About License

RSA BSAFE
Your printer includes RSA BSAFER Cryptographic software from EMC Corporation.

DES
This product includes software developed by Eric Young.
(eay@mincom.oz.au)

AES
Copyright© 2003, Dr BrianGladman, Worcester, UK. All rights reserved. This product uses published 
AES software provided by Dr Brian Gladmanunder BSD licensing terms.

TIFF(libtiff)
LibTIFFCopyright© 1988-1997 SamLeffler
Copyright© 1991-1997 Silicon Graphics, Inc.

JPEG
Our printer software uses some of the codes defined by the Independent JPEG Group.
About License 9



Types of Manuals

Safety Guide Describes the information you need to know before using the printer 
and to operate the printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

Also describes how to setup wireless network. (The wireless LAN 
feature is available only on the DocuPrint P255 dw model.)

User Guide (HTML files) 
(this guide)

Describes how to get ready to print and set various features. It also 
covers the operator panel menus, troubleshooting tips, and 
maintenance information.

This guide is on the Software Pack CD-ROM.

PostScript Level3 Compatible 
User Guide

Describes how to set up your printer as a PostScript Level3 Compatible 
printer and the features that can be configured on your print driver.

This guide is on the Software Pack CD-ROM.
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Using This Guide
This section includes:

• "Organization" on page 11
• "Conventions" on page 12

Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, power saver modes, 
and how to turn on the printer.

3 Printer Management Software Describes the software available for the printer.

4 Printer Connection and 
Software Installation

Describes the basic information about how to connect the printer to 
your computer and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print 
data using various print features.

6 Using the Operator Panel 
Menus

Describes the setting items available on the operator panel and their 
setup procedures.

7 Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

8 Maintenance Describes how to clean the printer, how to replace the toner cartridge, 
and how to see the printer status.

9 Contacting Fuji Xerox Describes support information.
Using This Guide 11



Conventions
1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 
• Important information that must be read and followed.

NOTE: 
• Additional information that merits emphasis.

See also: 
• References within this guide.

3 Orientation of documents or paper is described in this guide as follows:
, , Long Edge Feed (LEF): Loading the document or paper in the landscape orientation.

, , Short Edge Feed (SEF): Loading the document or paper in the portrait orientation.

4 The screen shots and illustrations in this guide are those of the DocuPrint P255 dw unless 
otherwise specified. Some of the items in the screen shots and illustrations may not be displayed 
or available depending on your printer model.

5 Some features are not available on some models.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
12 Using This Guide



Safety Notes
Before using this product, read “Safety Notes” carefully for safety use.
This product and recommended supplies have been tested and found to comply with strict safety 
requirements including safety agency approvals and compliance with environmental standards. Follow 
the following instructions for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:
• Any unauthorized alteration including an addition of new functions or connection to external devices 

may not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or 
fatal injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal 
injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid 
any dangerous acts.

: A symbol for items that must be performed. Follow instructions 
carefully to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
Safety Notes 13



Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult 
your local power company to check if your power source meets the requirements.

 CAUTION

WARNING:
• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an 
earthed electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an 
electrician to replace the outlet to avoid risk of electric shock. Never use an earthed adapter 
plug to connect the product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult 
your local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated 
ampere and voltage of this product. See the data plate on the rear panel of this product for its 
rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not put an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring 
about minute electric current in a connector. It may generate heat and eventually cause a fire 
accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and 
eventually cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk 
of electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior 
may cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live 
connector may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.
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Always switch off and unplug the machine when it is not used over weekends or long holidays. 
It may cause deterioration of insulations and eventually electric shock or a fire accident.

Once a month, switch off this product and check if
• the power cord is plugged firmly into an electrical outlet;
• the plug is not excessively heated, rusted or bent;
• the plug and electrical outlet are free of dust; and
• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.
Safety Notes 15



Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. 

Friction or excessive pressure may generate heat and eventually cause electric shock or a fire 
accident.

Never locate this product in the following places:
• Near radiators or any other heat sources
• Near volatile flammable materials such as curtains
• In the hot, humid, dusty or poorly ventilated environment
• In the place receiving direct sunlight
• Near cookers or humidifiers

Locate this product on a level and sturdy surface that can withstand a weight of 6.8 Kg. 
Otherwise, if tilted, the product may fall over and cause injuries.

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the 
product. 

Keep the minimum clearance as follows for ventilation and an access to the power plug. 
Unplug the product if an abnormal condition is noted.

300 mm 479 mm

100 mm

276 mm

385 mm

100 mm

225 mm

100 mm

585 mm

458 mm

300 mm 199 mm 280 mm

176 mm 100 mm

1055 mm
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Others

Do not incline the product at more than 1 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

To keep this product in a good performance and condition, always use it in the following 
environment: 
• Temperature: 10 – 32 °C
• Humidity: 10 – 85%

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.

1° 1°

1° 1°

Left Right Left Right

Front FrontRear Rear
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Operational Safety

 WARNING

 CAUTION

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in 
the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To 
prevent electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product 
promptly in the following conditions, then contact your local Fuji Xerox representative.
• The product emits smoke or its surface is unusually hot.
• The product emits unusual noise or odor.
• The power cord is cracked or worn down.
• A circuit breaker, fuse or any other safety device becomes activated.
• Any liquid is spilled into the product.
• The product is soaked in water.
• Any part of the product is damaged.

Do not insert any object into slots or openings of this product.
Do not put any of the followings on the product:
• Liquid container such as flower vases or coffee cups
• Metal parts such as staples or clips
• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or 
a fire accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated 
paper. When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other 
cleaning materials may result in poor performance of the product. Never use aerosol cleaners 
to avoid catching fire and explosion.

If you cannot remove the paper jam by doing the procedures in the manual, do not try to 
forcibly remove the jam. Doing so may cause injuries. Contact your local Fuji Xerox 
representative.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the “High 
Temperature” or “High Voltage” marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause 
injuries or electric shock.
18 Safety Notes



Do not attempt to remove a paper deeply jammed inside the product, particularly a paper 
wrapped around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. 
Switch off the product immediately and contact your local Fuji Xerox representative.

Ventilate well during extended operation or mass printing. It may affect the office air 
environment due to odor such as ozone in a poorly ventilated room.

Provide proper ventilation to ensure the comfortable and safe environment.
Safety Notes 19



Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills. 
It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill 
a large volume of toner, contact your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch 
fire and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox 
representative for its disposal.

Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of 
children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water 
and consult a physician immediately.

When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be 
careful not to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes 
and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes 
until irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Warning and Caution Labels
Always follow all warning instructions marked on or supplied with this product.
To avoid the risk of burn injuries and electric shock, never touch the area with the "High Temperature" 
or "High Voltage" marks on.

NOTE: 
• The following shows the toner cartridge label for DocuPrint P255 dw.
Safety Notes 21



Environment
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges and drums (photoreceptors) to make recycle parts, recycle materials or energy 
recovery.

• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges. 
Return them to your local Fuji Xerox representative.
22 Environment



Regulation

Radio Frequency Emissions (Class B)

Product Safety Certification (UL, CB)
This product is certified by the following agency using the safety standards listed.
Standard
IEC60950-1:ed. 2

This product has been tested and found to comply with the limits for a Class B digital device, 
pursuant to the International Standard for Electromagnetic Interference (CISPR Publ. 22) and 
Radiocommunications Act 1992 in Australia/New Zealand. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. This 
product generates, uses and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this 
product does cause harmful interference to radio or television reception, which can be 
determined by turning this product off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between this product and the receiver.
• Connect this product into an outlet on a circuit different from that to which the receiver is 

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the 
user’s authority to operate this product.
Regulation 23



Illegal Copies and Printouts
Copying or printing certain documents may be illegal in your country. Penalties of fines or 
imprisonment may be imposed on those found guilty. The following are examples of items that may be 
illegal to copy or print in your country. 

• Currency
• Banknotes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel.
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Product Features
This section describes the product features and indicates their links.

Duplex Print

When you have multiple pages to print, you can use 
the duplex feature of the computer to print on either 
side of paper to save paper consumption. 

For more information, see "Duplex Printing" on 
page 143.

Multiple Up Print

With the Multiple Up print feature of the printer, you 
can print multiple pages on a single sheet of paper 
to save paper consumption.

For more information, see the print driver's help.

Priority Sheet Inserter (PSI)

Print media loaded in the PSI is given precedence 
over the media in the paper tray. Using the PSI, you 
can print on print media of another type or size 
preferentially over the regular media in the paper 
tray.

For more information, see "Loading Print Media in 
the Priority Sheet Inserter (PSI)" on page 134.

Wireless Print (DocuPrint P255 dw only)

With the wireless LAN feature of the printer, you 
can place your printer at any location and print from 
a computer without cabling.

For more information, see "Configuring Wireless 
Network Settings (DocuPrint P255 dw only)" on 
page 62.
Product Features 25
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may 
change without prior notice.

Items Description
Product Code DocuPrint P255 dw 110V: TL300673

DocuPrint P255 dw 220V: TL300674

DocuPrint P255 d 220V: TL300675

DocuPrint P255 dw 220V: TL300687

Type Desktop

Printing Method LED Xerography

IMPORTANT: 
• LED + LED electrophotographic system

Fusing System Thermal fusing system using a belt

Warm-up Time Less than 26 seconds (after powering on at 22 °C temperature) 

Continuous Print Speed*1 A4 : When plain paper is fed from the paper tray

1 Sided*2: 30 sheets/min

IMPORTANT: 
*1 Print speed may decrease due to factors such as paper type, paper size, 

and printing conditions.
*2 When continuously printing a single document of A4 .

First Print 7 seconds or less (PCL, A4 /Fed from the paper tray)

IMPORTANT: 
• The period of time required to finish printing the first page of a 

print job after the printer receives the start command while it is 
ready to print. The first print output time does not apply to a job 
received right after the printer exits Low Power or Sleep mode or it 
is turned on.

Resolution Standard: 600 × 600 dpi

High Resolution: 1200 × 1200 dpi*
* When printing in high resolution mode, printing speed may be reduced 

due to image quality adjustment. Printing speed may also be reduced 
depending on documents.

Tone 256 tones
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Paper Size Paper tray:
A4, B5, A5, Letter (8.5 × 11"), Executive (7.25 × 10.5"), Folio (8.5 × 
13"), Legal (8.5 × 14"), Statement, Com-10, Monarch, DL, C5, 
Yougata 2/3, Yougata 4/6, Nagagata 3/4, Younaga 3, Kakugata 3, 
Postcard (100 × 148 mm), W-Postcard (148 × 200 mm), Custom 
Paper (Width: 76.2 - 215.9 mm, Length: 127 - 355.6 mm)

Priority Sheet Inserter (PSI):
A4, B5, A5, Letter (8.5 × 11"), Executive (7.25 × 10.5"), Folio (8.5 × 
13"), Legal (8.5 × 14"), Statement, Com-10, DL, C5, Yougata 4, 
Nagagata 3, Younaga 3, Kakugata 3, Custom Paper (Width: 76.2 - 
215.9 mm, Length: 210 - 355.6 mm)

Image loss: 4.1 mm from the top, bottom, left, and right edges

Paper Type Paper tray:
Plain (60 - 105 gsm), Lightweight Cardstock (106 - 163 gsm), 
Labels, Envelope, Recycled, Postcard JPN

Priority Sheet Inserter (PSI):
Plain (60 - 105 gsm), Lightweight Cardstock (106 - 163 gsm), 
Labels, Envelope, Recycled, Postcard JPN

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)
• Use only the recommended paper. Using paper other than that 

recommended for the printer can cause printing problems. For 
more information, see "Print Media That Can Damage Your 
Printer" on page 117.

• Note that poor printing quality due to paper-related printing 
problems can occur when using the printer in an environment that 
is dry, cold, or very humid. 

• Printing over the printed side or on the reverse side of paper that 
already has been printed on can result in poor print quality.

• When printing on envelopes, use envelopes that do not have 
adhesive applied.

• The type of paper being used and environmental conditions can 
affect printing quality. Because of this, it is recommended that you 
test print and confirm proper print quality before using the printer.

Paper Weight 60 - 163 gsm

Paper Capacity Standard:
Paper tray: 250 sheets
Priority Sheet Inserter (PSI): 10 sheets

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)

Output Tray Capacity Standard: approximately 125 sheets (face down)

IMPORTANT: 
• Fuji Xerox P paper (64 gsm) 

2-sided Printing Feature Standard

CPU 4305/300 MHz 

Items Description
28 Specifications



Memory Capacity Standard: 128 MB (Onboard)

IMPORTANT: 
• The above memory capacity does not guarantee print quality 

depending on the type and content of print data. 

Hard Disk —

Page Description Language Standard: PCL 5e, PCL 6, PostScript Level3 Compatible, PDF, TIFF, 
JPEG

Supported OS*1 Windows® XP, Windows® XP x64 Edition, Windows Vista®, Windows 
Vista® x64 Edition, Windows Server® 2003, Windows Server® 2003 
x64 Edition, Windows Server® 2008, Windows Server® 2008 x64 
Edition, Windows Server® 2008 R2 x64 Edition, Windows® 7, 
Windows® 7 x64 Edition, Mac OS®*2, Linux OS®*3

IMPORTANT: 
*1 For the latest information about the supported operating systems, contact 

our Customer Support Center or your dealer.
*2 Mac OS® X 10.4.11/10.5.8 - 10.6, 10.7 are supported.
*3 Red Hat Enterprise Linux 5/6 Desktop (x86), SUSE Linux Enterprise 

Desktop 10/11 (x86), and Ubuntu 8/10 (x86) are supported.

Interface Standard: USB 1.1/2.0 (Hi-Speed), Ethernet (10Base-T, 100Base-
TX), IEEE802.11b/g (DocuPrint P255 dw only)

Power AC 110 - 127 V ± 10%; 9 A; both 50/60 Hz

AC 220 - 240 V ± 10%; 5 A; both 50/60 Hz

IMPORTANT: 
• Maximum machine measured current

Operating Noise During operation: 7.37 B

During stand-by: 4.3 B

IMPORTANT: 
• Measurements based on ISO7779

Unit B: acoustic power level (LwAd)

Power Consumption In Sleep mode: 3.8 W or less

Average: 
During standby: 50 W, 
During continuous printing: 450 W

IMPORTANT: 
• Low Power mode: 8 W average

Dimensions 385 (W) × 355.6 (D)* × 225 (H) mm

IMPORTANT: 
* Measured when the paper tray is inserted.

Items Description
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Weight 6.8 kg (including consumables)

Usage Environment Temperature: 10 - 32 °C; Humidity: 10 - 85% (except malfunctions 
due to dew condensation)

Non-Use: Temperature: -20 - 40 °C; Humidity: 5 - 85% (except 
malfunctions due to dew condensation)

IMPORTANT: 
• Until the conditions (temperature and humidity) inside the printer 

become acclimated to the installation environment, certain 
qualities of the paper can cause poor printing. 

Items Description
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2
Basic Operation

This chapter includes:
• "Main Components" on page 32
• "Turning On the Printer" on page 35
• "Printing the Panel Settings Page" on page 36
• "Power Saver Mode" on page 37
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Main Components
This section provides an overview of your printer.
This section includes:

• "Front View" on page 32
• "Rear View" on page 33
• "Operator Panel" on page 34

Front View

1 Front Cover 2 Output Tray Extension

3 Priority Sheet Inserter (PSI) 4 Center Output Tray

5 Operator Panel 6 Power Switch

7 Toner Cartridge 8 Paper Tray Cover

9 Paper Tray 10 Paper Width Guides

11 Toner Access Cover

1 2 3 5 6 7

8 9 10 11

4

32 Basic Operation



Rear View

1 USB Port 2 Rear Cover Handle

3 Levers 4 Ethernet Port

5 Power Connector 6 Rear Cover

7 Paper Chute 8 Transfer Roller

9 Registration Roller 10 OPC Drum

321

4 5 6 7 8 9 10
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Operator Panel
The operator panel has a 2-line liquid crystal display (LCD), buttons, and LEDs.

1  (Energy Saver) Button/LED
• Lights up in the Sleep mode. Press this button to exit the Sleep mode.

2   Buttons
• Scrolls through menus or items in the Menu mode. To enter numbers or passwords, press 

these buttons.

3   Buttons
• Selects submenus or setting values in the Menu mode.

4  (Cancel Job) Button
• Cancels the current print job.

5  (Error) LED
• Lights up when the printer has a error.

6  (Ready) LED
• Lights up when the printer is ready.

7  (Back) Button
• Switches to the print mode from the top menu of the Menu mode.
• Returns to the upper hierarchy of the menu from the submenu of the Menu mode.

8  Button
• Displays the selected menu or item and determines the selected value in the Menu mode.

9 LCD Panel
• Displays various settings, instructions, and error messages. 

10  (Menu) Button
• Moves to the top menu.

OK 2

1

3
4

5

7

8

9

10

6
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Turning On the Printer
IMPORTANT: 
• Do not use extension cords or power strips.
• Do not connect the printer to an uninterruptible power supply (UPS) system.

1 Connect one end of the power cord to the power connector on the rear of the printer (see "Rear 
View" on page 33).

2 Connect the other end to a power source.

3 Turn on the printer.

NOTE: 
• When you turn on the printer for the first time, follow the on-screen instructions on the LCD panel to 

configure the initial settings of your printer.
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Printing the Panel Settings Page
The Panel Settings page shows current settings on the operator panel menus.
This section includes:

• "The Operator Panel" on page 36
• "The Printer Setting Utility (Windows Only)" on page 36

The Operator Panel
NOTE: 
• The reports and lists are all printed in English.

1 Press the  (Menu) button.

2 Select Report/List, and then press the  button.

3 Select Panel Settings, and then press the  button.
The Panel Settings page is printed.

The Printer Setting Utility (Windows Only)
The following procedure uses Microsoft Windows 7 as an example.

NOTE: 
• The reports and lists are all printed in English.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 
• The window to select a printer appears in this step when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility starts.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.
The Reports page is displayed.

4 Click the Panel Settings button.
The Panel Settings page is printed.
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Power Saver Mode
The printer has a power saving feature that reduces power consumption during periods of inactivity 
and operates in two modes: Low Power and Sleep. In Low Power mode, only the LCD panel goes 
blank. In Sleep mode, all LEDs, except for the  (Energy Saver) LED, on the operator panel go out 
and the LCD panel goes blank. When the printer is in Sleep mode, it consumes less power than in 
Low Power mode.
By default, the printer enters Low Power mode in one minute of inactivity after completion of the last 
print job, and then enters Sleep mode in another six minutes of inactivity. You can change these 
default settings in the following ranges:
Low Power mode: 1 to 30 minutes
Sleep mode: 6 to 11 minutes

See also: 
• "Changing the Power Saver Mode Settings" on page 187

Exiting the Power Saver Mode
The printer automatically exits the power saver mode when it receives a print job from a computer. 
Alternatively, you can manually bring it back to the ready-to-print state by pressing the  (Energy 
Saver) button. Whether the printer is in Low Power or Sleep mode, it will take about 25 seconds for 
the printer to resume the ready-to-print state.

NOTE: 
• In Low Power mode, opening and closing the rear cover will bring the printer back to the ready-to-print state.
• When the printer is in Sleep mode, all buttons on the operator panel except for the  (Energy Saver) button 

do not function. To use the buttons on the operator panel, press the  (Energy Saver) button to exit the 
power saver mode.

See also: 
• "Changing the Power Saver Mode Settings" on page 187
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3
Printer Management Software

Use the Software Pack CD-ROM supplied with your printer to install a combination of software 
programs, depending on your operating system.
This chapter includes:

• "Print Drivers" on page 40
• "CentreWare Internet Services" on page 41
• "Printer Setting Utility (Windows Only)" on page 42
• "SimpleMonitor (Windows Only)" on page 43
• "Launcher (Windows Only)" on page 44
• "User Setup Disk Creating Tool (Windows Only)" on page 45
Printer Management Software 39



Print Drivers
To access all of your printer’s features, install print drivers from the Software Pack CD-ROM. A printer 
driver enables communications between your computer and printer and provides access to your 
printer features.

See also: 
• "Installing Print Drivers on Computers Running Windows" on page 58
• "Installing Print Drivers on Computers Running Mac OS X" on page 97
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CentreWare Internet Services
This section provides information on the CentreWare Internet Services.
The CentreWare Internet Services is a hyper text transfer protocol (HTTP)-based web page service 
that is accessed through your web browser.
Using the CentreWare Internet Services, you can confirm the printer status, and change the printer 
configuration options easily. Anyone on your network can access the printer using the CentreWare 
Internet Services. In administrative mode, you can change the configuration of the printer and manage 
your printer settings without leaving your computer.

NOTE: 
• Users who are not given passwords by the administrator can still view the configuration settings in user mode. 

They will not be able to save or apply any changes to the current configuration and settings.
• For details on the menu items of the CentreWare Internet Services, refer to the Help on the CentreWare 

Internet Services.

Creating an Administrative Password
1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 
• The default ID and password are “11111” and “x-admin” respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the 
administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

9 Click Apply.
Your new password has been set and anyone with the administrator name and password can log 
in and change the printer configuration and settings.
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Printer Setting Utility (Windows Only)
The Printer Setting Utility allows you to view or specify the system settings. You can also diagnose the 
system settings with the Printer Setting Utility.
The Printer Setting Utility consists of the Printer Settings Report, Printer Maintenance, and 
Diagnosis tabs.
The Printer Setting Utility is installed along with print drivers.

NOTE: 
• The Password dialog box appears the first time you attempt to change settings on Printer Setting Utility when 

the Panel Lock feature is enabled on the printer. In this case, enter the password you specified, and click OK 
to apply the settings.
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SimpleMonitor (Windows Only)
You can check the printer status with the SimpleMonitor. Double-click the SimpleMonitor printer icon 
on the taskbar at the bottom right of the screen. The Printer Selection window appears, which 
displays the printer name, printer connection port, printer status, and model name. Check the column 
Status to know the current status of your printer. 
Settings button: Displays the Settings window and allows you to modify the SimpleMonitor settings.
Click the name of the desired printer listed on the Printer Selection window. The Printer Status 
window appears.
The Printer Status window alerts you when there is a warning or when an error occurs, for example, 
when a paper jam occurs or toner is running low.
By default, the Printer Status window appears automatically when an error occurs. You can specify 
the conditions for starting the Printer Status window in Printer Status Window Properties. 
To change the pop-up settings for the Printer Status window:

1 Right-click the SimpleMonitor printer icon on the taskbar at the bottom right of the screen.

2 Select Printer Status Window Properties.
The Printer Status Window Properties window appears.

3 Select the type of the pop-up and then click OK.
You can also check the toner level of your printer and the job information on the Printer Status 
window.
The SimpleMonitor is installed along with print drivers.
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Launcher (Windows Only)
Using the Launcher-Btype window, you can open the Status Window, Printer Setting Utility, and 
Troubleshooting.
To use the Launcher, select to install the Launcher when you install print drivers.
The following procedure uses Windows 7 as an example.
To start the Launcher:

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Launcher.
The Launcher-Btype window appears.

2 The Launcher-Btype window provides three buttons: Status Window, Printer Setting Utility, 
and Troubleshooting.
To exit, click the X button at the top-right of the window.

For more information, click the Help button/icon of each application.

Status Window Opens the Printer Status window. 

See also: 
• "SimpleMonitor (Windows Only)" on page 43

Printer Setting Utility Starts the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 42

Troubleshooting Opens the Troubleshooting guide, which allows you to resolve issues 
by yourself.
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User Setup Disk Creating Tool (Windows Only)
You can use the User Setup Disk Creating Tool program in the MakeDisk folder within the Utilities 
folder and drivers in the respective folders of the Software Pack CD-ROM to create a driver installation 
package. A driver installation package can contain a group of print driver settings and other data for 
things such as:

• Print orientation and Multiple Up print (document settings) 
• Watermarks 

If you want to install the print driver with the same settings on multiple computers running on the same 
operating system, create a setup disk in a floppy disk or in a server on the network. Using the setup 
disk that you have created will reduce the amount of work required when installing the print driver.

• Install print drivers for your printer on the computer on which the setup disk is to be created.
• The setup disk can only be used on the operating system on which the disk was created or 

computers running the same operating system. Create a separate setup disk for each of the 
operating systems.

To create a setup disk, follow the procedure below. The procedure uses Windows 7 as an example.

1 Right-click the icon for your printer in the Devices and Printers folder and select Printing 
preferences to open the print driver window.

2 Specify the settings that you want to include in a driver installation package (for example, the 
Multiple Up setting on the Layout tab).

3 Insert the Software Pack CD-ROM into the CD/DVD drive and open the disc.

NOTE: 
• If the AutoPlay window appears, click Open folder to view files.

4 Double-click Utilities → MakeDisk → your desired language.

5 Double-click makedisk.exe.
The Creating Setup Disk window appears.
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6 Select your printer and click Create Disk.
The Setup Disk Settings window appears.

7 Enter a description of your printer settings in the Comment field and select an output port from 
the Port list box.

NOTE: 
• Alternatively, you can click Add Port to create your desired port.
• Select the Set as default printer check box as needed.

8 Click Create Setup Disk.
The Specifying Setup Disk Directory window appears.

9 Enter the path to the destination folder directly into the Destination folder box or click Browse 
to select the folder.

10 Click OK.
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4
Printer Connection and Software 
Installation

This chapter includes:
• "Overview of Network Setup and Configuration" on page 48
• "Connecting Your Printer" on page 49
• "Setting the IP Address" on page 52
• "Installing Print Drivers on Computers Running Windows" on page 58
• "Installing Print Drivers on Computers Running Mac OS X" on page 97
• "Installing Print Drivers on Computers Running Linux (CUPS)" on page 103
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Overview of Network Setup and Configuration
To set up and configure the network:

1 Connect the printer to the network using the recommended hardware and cables.

2 Turn on the printer and the computer.

3 Print the System Settings page and keep it for referencing network settings. 

4 Install the driver software on the computer from the Software Pack CD-ROM. For information on 
driver installation, see the section in this chapter for the specific operating system you are using.

5 Configure the printer’s TCP/IP address, which is required to identify the printer on the network. 
• Microsoft Windows operating systems: Run the installer on the Software Pack CD-ROM to 

automatically set the printer’s Internet Protocol (IP) address if you connect the printer to an 
established TCP/IP network. You can also manually set the printer’s IP address on the 
operator panel.

• Mac OS X and Linux systems: Manually set the printer’s TCP/IP address on the operator 
panel. To use a wireless connection (DocuPrint P255 dw only), also configure wireless 
network settings on the operator panel.

6 Print the System Settings page to verify the new settings.

NOTE: 
• The reports and lists are all printed in English.
• If the Software Pack CD-ROM is not available, you can download the latest driver from our web site: 

http://www.fujixeroxprinters.com/ 

See also: 
• "Printing the System Settings Page" on page 156
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Connecting Your Printer
The interface cables of your printer must meet the following requirements:

Connection Type Connection Specifications
Ethernet 10 Base-T/100 Base-TX compatible

USB USB 2.0 compatible

Wireless (DocuPrint P255 dw only) IEEE 802.11b/802.11g

1 USB Port

2 Ethernet Port

1

2
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Connecting Printer to a Computer or a Network
Connect your printer via a USB, Ethernet, or wireless (DocuPrint P255 dw only) connection. Hardware 
and cabling requirements vary for the different connection methods. Ethernet cables and hardware 
are not supplied with your printer and must be purchased separately.
The available features for each connection type are shown in the following table.

USB Connection
If your printer is connected to a network instead of your computer, skip this section and go to "Network 
Connection" on page 51.
To connect the printer to a computer:

1 Connect the smaller end of the supplied USB cable to the USB port on the rear of the printer, and 
the other end to a USB port on the computer.

NOTE: 
• Do not connect the printer USB cable to the USB connector available on the keyboard.

Connection Type Available Features
USB When connected via USB you can:

• Instruct print jobs from a computer.
• Use the SimpleMonitor to check the printer status.

Ethernet When connected via Ethernet you can:
• Instruct print jobs from a computer on the network.
• Use the SimpleMonitor to check the printer status.

Wireless (DocuPrint P255 dw only) When connected via wireless you can:
• Instruct print jobs from a computer on the network.
• Use the SimpleMonitor to check the printer status.

USB port
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Network Connection
To connect the printer to an Ethernet network:

1 Ensure that the printer, computer and any other connected devices have been turned off and all 
cables have been disconnected.

2 Connect one end of an Ethernet cable to the Ethernet port on the rear of the printer, and the 
other end to a LAN drop or hub.

NOTE: 
• Do not connect the Ethernet cable when you intend to use the wireless network feature of the DocuPrint P255 

dw model.

See also: 
• "Configuring Wireless Network Settings (DocuPrint P255 dw only)" on page 62

Ethernet port
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Setting the IP Address
This section includes:

• "TCP/IP and IP Addresses" on page 52
• "Automatically Setting the Printer’s IP Address" on page 52
• "Dynamic Methods of Setting the Printer’s IP Address" on page 53
• "Assigning an IP Address (for IPv4 Mode)" on page 54
• "Verifying the IP Settings" on page 56
• "Printing and Checking the System Settings Page" on page 56

TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP 
addresses and additional system settings information. 
If you are creating your own small Local Area Network or connecting the printer directly to your 
computer using Ethernet, follow the procedure for automatically setting the printer’s IP address. 
Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
With TCP/IP protocols, each printer and computer must have a unique IP address. It is important that 
the addresses are similar, but not the same; only the last digit needs to be different. For example, your 
printer can have the address 192.168.1.2 while your computer has the address 192.168.1.3. Another 
device can have the address 192.168.1.4.
Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically programs an IP address into every computer and printer on the network that is 
configured to use DHCP. A DHCP server is built into most cable and Digital Subscriber Line (DSL) 
routers. If you use a cable or DSL router, see your router’s documentation for information on IP 
addressing.

Automatically Setting the Printer’s IP Address
If the printer is connected to a small established TCP/IP network without a DHCP server, use the 
installer on the Software Pack CD-ROM to detect or assign an IP address to your printer. For further 
instructions, insert the Software Pack CD-ROM into your computer's CD/DVD drive. After the Installer 
starts, follow the prompts for installation. 

NOTE: 
• For the automatic installer to function, the printer must be connected to an established TCP/IP network.
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Dynamic Methods of Setting the Printer’s IP Address
There are two protocols available for dynamically setting the printer’s IP address: 

• DHCP
• DHCP/Auto IP (enabled by default)

You can turn on/off either protocol using the operator panel, or use the CentreWare Internet Services 
to turn on/off the DHCP protocol.

NOTE: 
• You can print a report that includes the printer’s IP address. On the operator panel, press the  (Menu) 

button, select Report/List, press the  button, select System Settings, and then press the  button. 
The IP address is listed on the System Settings page.

Using the Operator Panel
To turn on/off either the DHCP or the AutoIP protocol:

1 On the operator panel, press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select TCP/IP, and then press the  button.

5 Select IPv4, and then press the  button.

6 Select Get IP Address, and then press the  button.

7 Select DHCP/AutoIP or DHCP, and then press the  button.

Using the CentreWare Internet Services
To turn on/off the DHCP protocol:

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.
The CentreWare Internet Services appear on your browser.

3 Select Properties.

4 Select TCP/IP from the Protocol Settings folder on the left navigation panel.

5 In the IP Address Mode field, select the DHCP/AutoIP option.

6 Click the Apply button.
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Assigning an IP Address (for IPv4 Mode)
NOTE: 
• When you assign an IP address manually in IPv6 mode, use the CentreWare Internet Services. To display the 

CentreWare Internet Services, use the link local address. To check a link local address, see "Printing and 
Checking the System Settings Page" on page 56.

• Assigning an IP address is considered as an advanced function and is normally done by a system 
administrator.

• Depending on the address class, the range of the IP address assigned may be different. On Class A, for 
example, an IP address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment 
of IP addresses, contact your system administrator. 

You can assign the IP address by using the operator panel or the Printer Setting Utility.

Using the Operator Panel

1 Turn on the printer.
Ensure that the LCD panel shows Ready to Print.

2 On the operator panel, press the  (Menu) button.

3 Select Admin Menu, and then press the  button.

4 Select Network, and then press the  button.

5 Select TCP/IP, and then press the  button.

6 Select IPv4, and then press the  button.

7 Select Get IP Address, and then press the  button.

8 Select Panel, and then press the  button.

9 Press the  (Back) button, and then ensure that Get IP Address is selected.

10 Select IP Address, and then press the  button.

11 Enter the value of the IP address using the  or  button.

12 Press the  button.

13 Repeat steps 11 and 12 to enter all of the digits in the IP address, and then press the  button.

14 Press the  (Back) button, and then ensure that IP Address is selected.

15 Select Subnet Mask, and then press the  button.

16 Enter the value of the subnet mask using the  or  button.

17 Press the  button.

18 Repeat steps 16 and 17 to set subnet mask, and then press the  button.

19 Press the  (Back) button, and then ensure that Subnet Mask is selected.

20 Select Gateway Address, and then press the  button.
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21 Enter the value of the gateway address using the  or  button.

22 Press the  button.

23 Repeat steps 21 and 22 to set gateway address, and then press the  button.

24 Turn off and turn on the printer.

See also: 
• "Operator Panel" on page 34

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

NOTE: 
• When you use IPv6 mode for network printing, you cannot use the Printer Setting Utility to assign an IP 

address.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 
• The window to select a printer appears in this step when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility starts.

2 Click the Printer Maintenance tab.

3 Select TCP/IP Settings from the list at the left side of the page.
The TCP/IP Settings page is displayed.

4 Select Panel from IP Address Mode, and then enter the values in IP Address, Subnet Mask, 
and Gateway Address.

5 Click the Restart printer to apply new settings button to take effect.
The IP address is assigned to your printer. To verify the setting, display the web browser on any 
computer connected to the network and enter the IP address into the address bar on the browser. If 
the IP address is set up correctly, the CentreWare Internet Services appears on your browser.
You can also assign the IP address to the printer when installing the print drivers with installer. When 
you use the network installation feature, and the Get IP Address is set to DHCP or DHCP/AutoIP 
on the operator panel menus, you can set the IP address from 0.0.0.0 to the desired IP address on 
the printer selection window. 
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Verifying the IP Settings
The following procedure uses Windows 7 as an example.

NOTE: 
• The reports and lists are all printed in English.

1 Print the System Settings page.

2 Look under the IPv4 heading on the System Settings page to ensure that the IP address, subnet 
mask, and gateway address are appropriate.

To verify if the printer is active on the network, run the ping command in your computer:

1 Click Start, and select Search programs and files.

2 Enter cmd, and then press the Enter key.
A black window appears.

3 Enter ping xx.xx.xx.xx (where xx.xx.xx.xx is the IP address of your printer), and then press the 
Enter key.

4 Reply from the IP address denotes printer is active on the network.

See also: 
• "Printing and Checking the System Settings Page" on page 56

Printing and Checking the System Settings Page
Print the System Settings page and check your printer's IP address.
This section includes:

• "Using the Operator Panel" on page 56
• "Using the Printer Setting Utility (Windows Only)" on page 57

Using the Operator Panel
NOTE: 
• The reports and lists are all printed in English.

1 Press the  (Menu) button.

2 Select Report/List, and then press the  button.

3 Select System Settings, and then press the  button.
The System Settings page is printed.

4 Confirm the IP address next to IP Address under Wired Network (DocuPrint P255 d) or Wired 
Network/Wireless Network (DocuPrint P255 dw) on the System Settings page. If the IP 
address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print 
the System Settings page again.
If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on 
page 54.
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Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

NOTE: 
• The reports and lists are all printed in English.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 
• The window to select a printer appears in this step when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility starts.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.
The Reports page appears.

4 Click the System Settings button.
The System Settings page is printed.

If the IP address is 0.0.0.0 (the factory default) or 169.254.xx.xx, an IP address has not been 
assigned. 

See also: 
• "Assigning an IP Address (for IPv4 Mode)" on page 54
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Installing Print Drivers on Computers Running 
Windows 
You can use three types of print drivers on your printer: PCL, PostScript Level3 Compatible, and XML 
Paper Specification print drivers. This section provides information on the PCL print driver.
For information on the other drivers, see the following:

This section includes:
• "Identifying Print Driver Pre-install Status (for Network Connection Setup)" on page 59
• "Inserting the Software Pack CD-ROM" on page 60
• "USB Connection Setup" on page 60
• "Network Connection Setup" on page 61
• "Configuring Wireless Network Settings (DocuPrint P255 dw only)" on page 62
• "Setting Up the Printer for Shared Printing" on page 87
• "Using the XML Paper Specification Print Driver" on page 96

PostScript Level3 Compatible print driver: PostScript Level3 Compatible User Guide
XML Paper Specification print driver: "Using the XML Paper Specification Print Driver" on 

page 96
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Identifying Print Driver Pre-install Status (for Network 
Connection Setup)

Before installing print drivers on your computer, print the System Settings page to check the IP 
address of your printer.
This section includes:

• "Using the Operator Panel" on page 59
• "Using the Printer Setting Utility" on page 59
• "Disabling the Firewall Before Installing Printer Drivers" on page 60

Using the Operator Panel
NOTE: 
• The reports and lists are all printed in English.

1 Press the  (Menu) button.

2 Select Report/List, and then press the  button.

3 Select System Settings, and then press the  button.
The System Settings page is printed.

4 Find the IP address under Wired Network (DocuPrint P255 d) or Wired Network/Wireless 
Network (DocuPrint P255 dw) on the System Settings page.
If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and 
then print the System Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on 
page 54.

Using the Printer Setting Utility
The following procedure uses Windows 7 as an example.

NOTE: 
• The reports and lists are all printed in English.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 
• The window to select a printer appears in this step when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility starts.

2 Click the Printer Settings Report tab.

3 Select TCP/IP Settings from the list on the left side of the page.
The TCP/IP Settings page is displayed.

If the IP address shows 0.0.0.0 (the factory default) or 169.254.xx.xx, an IP address has not been 
assigned. To assign one for your printer, see "Assigning an IP Address (for IPv4 Mode)" on page 54.
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Disabling the Firewall Before Installing Printer Drivers
If you are running one of the following operating systems, you must disable the firewall before 
installing print drivers:

• Windows 7
• Windows Vista
• Windows Server 2008 R2
• Windows Server 2008
• Windows XP

The following procedure uses Windows 7 as an example.

1 Click Start → Help and Support.

NOTE: 
• For Windows Vista, Windows Server 2008, Windows Server 2008 R2 and Windows 7 operating systems, 

if you use Online Help, switch to Offline Help on Windows Help and Support window.

2 In the Search Help box, enter firewall and then press the Enter key.
In the list, click Turn Windows Firewall on or off and then follow the instructions on the screen.

Enable the firewall after the installation of the printer software is complete.

Inserting the Software Pack CD-ROM
1 Insert the Software Pack CD-ROM into your computer's CD/DVD drive. When the AutoPlay 

window appears, click Run setup.exe to start the Easy Install Navi.

NOTE: 
• If the CD does not automatically start or the AutoPlay window does not appear, click Start (start for 

Windows XP) → Computer → D:\setup.exe (where D is the drive letter of your CD), and then click OK.

USB Connection Setup
The following procedure uses Windows 7 as an example.

1 Connect your computer and printer with a USB cable.

2 Turn on the printer.

3 Click Installing Drivers and Software.

4 Select Personal Installation, and then click Next.

5 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

6 Select whether to restart your computer and click Finish to exit the wizard.

• USB Printing
A personal printer is a printer connected to your computer or a print server using a USB. If your printer 
is connected to a network and not to your computer, see "Network Connection Setup" on page 61.
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Network Connection Setup
NOTE: 
• To use your printer in a Linux environment, you need to install print drivers for the Linux operating systems. 

For details on how to install and use the drivers, see also "Installing Print Drivers on Computers Running Linux 
(CUPS)" on page 103.

• When using a CD drive in a Linux environment, you need to mount the drive to your system environment. The 
command strings are mount/media/CD-ROM.

The following procedure uses Windows 7 as an example.

1 Click Installing Drivers and Software.

2 Select Network Installation, and then click Next.

3 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

4 Select the printer you want to install from the printer list, and then click Next. If the target printer 
is not displayed on the list, click Refresh to refresh the list or click Add Printer to add a printer to 
the list manually. You may specify the IP address and port name at this point.
If you have installed this printer on the server computer, select I am setting up this printer on a 
server check box.

NOTE: 
• If the installer displays 0.0.0.0 when you intend to use the AutoIP feature, you must enter a 

valid IP address to continue.

5 Specify the printer settings, and then click Next.
a Enter the printer name.
b If you want other users on the network to access this printer, select Share this printer with 

other computers on the network, and then enter a share name that users can identify.
c If you want to set a printer as the default for printing, select the Set this printer as default 

for printing check box.

6 Select the software and documentation you want to install, and then click Install. You can specify 
folders in which to install the software and documentation. To change the folders, click Browse.

7 Click Finish to exit the wizard.
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Configuring Wireless Network Settings (DocuPrint 
P255 dw only)

You can configure wireless network settings with the Easy Install Navi.

IMPORTANT: 
• Be sure to obtain the SSID and security information from a system administrator in advance when you use a 

communications standard other than WPS to configure wireless network settings.
• Ensure that the Ethernet cable has been disconnected from the printer before you configure the wireless 

network settings.

The wireless network specifications are described below:

You can select a method to configure wireless network settings from the following:

This section includes:
• "Using Wizard Setup to Configure Wireless Network Settings" on page 63
• "Using Advanced Setup to Configure Wireless Network Settings" on page 68
• "Setting Up a New Wireless Network Environment for Your Computer (When You Need to Set Up 

Your Wireless Connectivity With Your Computer)" on page 78

Item Specification
Connectivity Wireless

Connectivity Standard IEEE 802.11b/g compliant

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11b mode: 11, 5.5, 2, 1 Mbps 

IEEE 802.11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps 

Security 64 (40-bit key)/ 128 (104- bit key) WEP, WPA- PSK (TKIP, AES), 
WPA2-PSK (AES)(IEEE802.1x attestation function of WPA 1x non-
corresponds)

Certifications Wi-Fi, WPA2.0 (Personal)

Wi-Fi Protected Setup (WPS) Push Button Configuration (PBC), Personal Identification Number 
(PIN)

Wizard Setup Through USB Connection

Advanced Setup Through Ethernet connection

Operator Panel

CentreWare Internet Services

WPS-PIN*1

WPS-PBC*2

*1 WPS-PIN (Wi-Fi® Protected Setup-Personal Identification Number) is a method to authenticate and 
register devices required for wireless configuration, by entering PIN code in the printer and computer. 
This setting, performed through access point, is available only when the access points of your wireless 
router supports WPS.

*2 WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register 
devices required for wireless configuration, by pressing the button provided on the access point via 
wireless routers, and then performing WPS-PBC setting on the operator panel. This setting is available 
only when the access point supports WPS.
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Using Wizard Setup to Configure Wireless Network Settings
The following procedure uses Windows 7 as an example.

1 Insert the Software Pack CD-ROM into your computer's CD/DVD drive. When the AutoPlay 
window appears, click Run setup.exe to start the Easy Install Navi.

2 Click Start Setup.

3 Click Connect Your Printer.
The connection type selection screen appears.

4 Select Wireless Connection, and then click Next.
The setting method selection screen appears.
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5 Ensure that Wizard is selected, and then click Next.

6 Follow the on-screen instructions to connect the USB cable and perform other setup until the 
Printer Setup Utility screen appears.

7 Select either of the following:
• Click the Select from the found Access Points radio button and select the SSID.
• Click the Input the SSID directly radio button and enter the SSID in the SSID box.

8 Click Next.

9 Select Type of wireless network.

10 Configure the security setting, and then click Next.
The IP Address Settings screen appears.
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11 Select IP Mode depending on your network scheme.
When IPv4 is selected, configure the following:

a Select Type.
b If you have selected Use Manual Address from Type, enter the following items:

• IP Address of your printer
• Subnet Mask
• Gateway Address

When Dual Stack is selected, configure the following:

a Configure IPv4 Settings.
b If you have selected the Use Manual Address check box under IPv6 Settings, enter the 

following items:
• IP Address of your printer
• Gateway Address
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12 Click Next.
The Confirm the settings screen appears.

13 Ensure that the wireless network settings are displayed, and then click Apply.
A confirmation window appears.

14 Click Yes.

15 Wait a few minutes until the printer restarts to establish a wireless network connection and the 
Configuration Complete screen appears.

16 Click Print Printer Setting.
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17 Confirm that "Link Quality" is shown as "Good", "Acceptable", or "Low" on the report.

NOTE: 
• When "Link Quality" is shown as "No Reception", check if the wireless network settings are correctly 

configured. To reconfigure the wireless network settings, click Next on the Configuration Complete 
screen and then click Return.

18 Click Next.

19 Follow the on-screen instructions until the Check Setup screen appears.

20 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

21 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

22 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Add Printer, and then enter the details of the printer manually.

23 Select the required items on the Enter Printer Settings screen, and then click Next.

24 Select the software to be installed, and then click Install.

25 Click Finish to exit this tool.
The wireless configuration is complete.
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Using Advanced Setup to Configure Wireless Network Settings
To use the Advanced setup, display the Configure Wireless Settings screen.
The following procedure uses Windows 7 as an example.

• Displaying the Configure Wireless Settings Screen

1 Insert the Software Pack CD-ROM into your computer's CD/DVD drive. When the AutoPlay 
window appears, click Run setup.exe to start the Easy Install Navi.

2 Click Start Setup.

3 Click Connect Your Printer.

4 Select Wireless Connection, and then click Next.
The setting method selection screen appears.
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5 Select Advanced.
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• Select a connection method from the following
• "Ethernet Cable" on page 70
• "WPS-PIN" on page 74
• "WPS-PBC" on page 75
• "Operator Panel" on page 76
• "CentreWare Internet Services" on page 77

• Ethernet Cable

1 Select Ethernet Cable, and then click Next.

2 Follow the on-screen instructions, and then click Next.
The Printer Setup Utility screen appears.

3 Select the printer to be configured in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be configured is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Enter IP Address, and then enter the IP address of your printer.

4 Enter the SSID.

5 Select Type of wireless network.

6 Configure the security setting, and then click Next.
The IP Address Settings screen appears.
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7 Select IP Mode depending on your network scheme.
When IPv4 is selected, configure the following:

a Select Type.
b If you have selected Use Manual Address from Type, enter the following items:

• IP Address of your printer
• Subnet Mask
• Gateway Address

When Dual Stack is selected, configure the following:

a Configure IPv4 Settings.
b If you have selected the Use Manual Address check box under IPv6 Settings, enter the 

following items:
• IP Address of your printer
• Gateway Address
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8 Click Next.
The Confirm the settings screen appears.

9 Ensure that the wireless network settings are displayed, and then click Apply.
A confirmation window appears.

10 Click Yes.

11 Wait a few minutes until the printer restarts to establish a wireless network connection and the 
Configuration Complete screen appears.

12 Click Next.

13 Follow the on-screen instructions until the Check Setup screen appears.
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14 Print the System Settings page using the operator panel.
See "Printing the System Settings Page" on page 156.

15 Confirm that "Link Quality" is shown as "Good", "Acceptable", or "Low" on the report.

NOTE: 
• When "Link Quality" is shown as "No Reception", check if the wireless network settings are correctly 

configured. To reconfigure the wireless network settings, click Return.

16 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

17 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

18 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Add Printer, and then enter the details of the printer manually.

19 Configure the required items on the Enter Printer Settings screen, and then click Next.

20 Select the software to be installed, and then click Install.

21 Click Finish to exit this tool.
The wireless configuration is complete.
Printer Connection and Software Installation 73



• WPS-PIN
NOTE: 
• WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register 

devices required for wireless configuration, by entering PIN code to a printer and computer. This setting, 
performed through access point, is available only when the access points of your wireless router supports 
WPS.

• Before WPS-PIN starts, you will need to enter your PIN code at the web page of the wireless access point. 
See the access point manual for the details.

1 Select WPS-PIN, and then click Next.

2 Follow the on-screen instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Add Printer, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.

8 Click Finish to exit this tool.
The wireless configuration is complete.

When the WPS-PIN operation is successful and the printer is rebooted, wireless LAN connection is 
completed.
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• WPS-PBC
NOTE: 
• WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register 

devices required for wireless configuration, by pressing the button provided on the access point via wireless 
routers, and then performing WPS-PBC setting on the operator panel. This setting is available only when the 
access point supports WPS.

1 Select WPS-PBC, and then click Next.

2 Follow the on-screen instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:
• Click Refresh to update the information.

- Click Add Printer, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.

8 Click Finish to exit this tool.
The wireless configuration is complete.

NOTE: 
• For the WPS-PBC operation on the wireless LAN access point, refer to the manual supplied with the wireless 

LAN access point.
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When the WPS-PBC operation is successful and the printer is rebooted, wireless LAN connection is 
completed.

• Operator Panel

1 Select Operator Panel, and then click Next.

2 Follow the on-screen instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Add Printer, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.

8 Click Finish to exit this tool.
The wireless configuration is complete.
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• CentreWare Internet Services

1 Select CentreWare Internet Services, and then click Next.

2 Follow the on-screen instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Add Printer, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.

8 Click Finish to exit this tool.
The wireless configuration is complete.

When the CentreWare Internet Services operation is successful and the printer is rebooted, wireless 
LAN connection is completed.
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Setting Up a New Wireless Network Environment for Your Computer 
(When You Need to Set Up Your Wireless Connectivity With Your 
Computer)

• For DHCP Networks:

1 Setting up your computer for wireless connectivity:

NOTE: 
• You can also change the wireless network settings using the wireless application that may be installed on 

your computer.
For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select the Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.

NOTE: 
• Make note of the wireless network settings on the Advanced dialog box (step f) and the Wireless 

network properties dialog box (step h). You may require these settings later.

e Click the Advanced button.
f Select Computer-to-computer (ad hoc) networks only and close the Advanced dialog 

box.
g Click the Add button to display Wireless network properties.
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h On the Association tab, enter the following information and click OK.
Network name (SSID): xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you 
use)

Network Authentication: Open

Data encryption: Disabled

i Click the Move up button to move the newly added SSID to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box. 
For Windows Vista:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
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For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.

2 Check the IP address assigned by AutoIP on the printer.
a On the operator panel, press the  (Menu) button.
b Select Admin Menu, and then press the  button.
c Select Network, and then press the  button.
d Select TCP/IP, and then press the  button.
e Select IPv4, and then press the  button.
f Select IP Address, and then press the  button.

(Default IP address range: 169.254.xxx.yyy)

3 Ensure that the IP Address on your computer is assigned by DHCP.

4 Launch your web browser.

IP Address

169.254.000.041*
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5 Enter the IP address of the printer in the address bar, and then press the Enter key.
The CentreWare Internet Services appears on your browser.

6 Configure wireless network settings for the printer on the CentreWare Internet Services.

7 Reboot the printer.

8 Restore the wireless network settings on your computer.

NOTE: 
• If the operating system on your computer provides a wireless configuration software, use it to change the 

wireless network settings. See the instructions below.
For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select the Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.
e Click Advanced.
f You can either set the printer to the ad-hoc mode or the infrastructure mode.
• For Ad hoc mode:

Select Computer-to-computer (ad hoc) networks only and close the dialog box.

• For Infrastructure mode:
Select Access point (Infrastructure) networks only and close the dialog box.

g Click Add to display Wireless network properties.
h Enter the setting that you will send to the printer and click OK.
i Click Move up to move the setting to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box. 
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For Windows Vista:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.

• For Fixed IP Networks:

1 Set up your computer for wireless connectivity:

NOTE: 
• If the operating system on your computer provides a wireless configuration software, use it to change the 

wireless network settings. See the instructions below.
For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select the Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.

NOTE: 
• Be sure to write down the current wireless computer settings in step f and step h so that you can restore 

them later.

e Click the Advanced button.
f Select Computer-to-computer (ad hoc) networks only and close the Advanced dialog 

box.
g Click the Add button to display Wireless network properties.
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h On the Association tab, enter the following information and click OK.
Network name (SSID): xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you 
use)

Network Authentication: Open

Data encryption: Disabled

i Click the Move up button to move the newly added SSID to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box.
For Windows Vista:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
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For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.

2 Check the IP address on your computer.

3 Set the IP address on the printer.
See "Assigning an IP Address (for IPv4 Mode)" on page 54.

4 Launch your web browser.
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5 Enter the IP address of the printer in the address bar, and then press the Enter key.
The CentreWare Internet Services appears on your browser.

6 Change the wireless network settings for the printer on the CentreWare Internet Services.

7 Reboot the printer.

8 Restore the wireless network settings on your computer.

NOTE: 
• If the operating system on your computer provides a wireless configuration software, use it to change the 

wireless network settings. Or you can change the wireless network settings using the tool provided with 
the operating system. See the instructions below.

For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select the Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.
e Click Advanced.
f You can either set the printer to the ad-hoc mode or the infrastructure mode.
• For Ad hoc mode:

Select Computer-to-computer (ad hoc) networks only and close the dialog box.

• For Infrastructure mode:
Select Access point (Infrastructure) networks only and close the dialog box.
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g Click Add to display Wireless network properties.
h Enter the setting that you will send to the printer and click OK.
i Click Move up to move the setting to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box. 
For Windows Vista:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
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Setting Up the Printer for Shared Printing
One way to make a new printer available for other computers on a network is to use the Software 
Pack CD-ROM supplied with your printer. Using the supplied CD is helpful in a way that it will install 
utilities including the SimpleMonitor as well. The following, however, describes the procedures for 
sharing a printer on a network without using the supplied CD.
To set up a printer to be shared on a network, you need to set up the printer for network sharing and 
install print drivers for the printer on every computer on the network.

NOTE: 
• You need to purchase an additional Ethernet cable at your own cost to connect a printer to an Ethernet 

network.

Setting Up the Printer for Network Sharing

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the icon for your printer and select Properties.

3 From the Sharing tab, select Share this printer, and then enter a name in the Share name text 
box.

4 Click Additional Drivers and select the operating systems of all network clients using your 
printer.

5 Click OK.
If the files are not present in your computer, and then you will be prompted to insert the server 
operating system CD.

6 Click Apply, and then click OK.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options button.

4 The "Windows needs your permission to continue" appears.

5 Click Continue button.

6 Select the Share this printer check box, and then enter a name in the Share name text box.

7 Select Additional Drivers and select the operating systems of all network clients using your 
printer.

8 Click OK.

9 Click Apply, and then click OK.
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in the Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using your 
printer.

5 Click OK.

6 Click Apply, and then click OK.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in the 
Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using your 
printer.

5 Click OK.

6 Click Apply, and then click OK.
To check that the printer is shared:

• Ensure that the printer object in the Printers, Printers and Faxes or Devices and Printers 
folder is shared. The share icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and look for the 
shared name you assigned to the printer.
88 Printer Connection and Software Installation



Installing Print Drivers
Now that the printer is set for shared printing, you need to install print drivers for the shared printer 
using either of the two Windows features.

• Using the Point and Print Feature
The Point and Print feature is a Microsoft Windows technology that automatically downloads and 
installs a print driver necessary for using the shared printer on the network.

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

Wait until the driver is copied from the server to the client computer and a new printer object is 
added to the Printers and Faxes folder. It may take some time depending on the amount of 
network traffic.

Close My Network Places.

4 Print a test page to verify installation.
a Click start (Start for Windows Server 2003/Windows Server 2003 x64 Edition) → Printers 

and Faxes.
b Select the printer you have installed.
c Click File → Properties.
d On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.
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For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Network.

2 Locate and double-click the host name of the server computer.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.
Wait until the driver is copied from the server to the client computer and a new printer object is 
added to the Printers folder. It may take some time depending on the amount of network traffic.

6 Print a test page to verify installation.
a Click Start → Control Panel → Hardware and Sound.
b Select Printers.
c Right-click the printer you just created and select Properties.
d On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer and a new printer object will 
be added to the Printers folder. It may take some time depending on the amount of network 
traffic.

6 Print a test page to verify installation.
a Click Start → Control Panel.
b Select Hardware and Sound.
c Select Printers.
d Right-click the printer you just created and select Properties.
e On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.
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For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Computer → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer and a new printer object will 
be added to the Devices and Printers folder. It may take some time depending on the amount of 
network traffic.

6 Print a test page to verify installation.
a Click Start → Devices and Printers.
b Right-click the printer you just created and select Printer properties.
c On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.
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• Using the Peer-to-Peer Feature
With the peer-to-peer feature, you need to specify the shared printer to install a print driver.

For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click start (Start for Windows Server 2003/Windows Server 2003 x64 Edition) → Printers and 
Faxes.

2 Click Add a printer (Add Printer for Windows Server 2003/Windows Server 2003 x64 Edition) 
to launch the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next.

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next. If the printer is not listed, click Back and enter the path to 
the printer in the text box.

The server host name is the name of the server computer that identifies it to the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

7 Select Yes if you want your printer to be set as the default printer, and then click Next.

8 Click Finish.

For example:\\<server host name>\<shared printer name>
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For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and enter the path to the printer in 
the Select a shared printer by name text box and click Next.

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

4 Confirm the printer name, and then select whether to use your printer as the default printer and 
click Next.

5 If you want to verify installation, click Print a test page.

6 Click Finish.
When a test page is printed successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and enter the path to the printer in 
the Select a shared printer by name text box and click Next.
For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

4 Confirm the printer name, and then select whether to use your printer as the default printer and 
click Next.

5 Select whether to share your printer or not.

6 If you want to verify installation, click Print a test page.

7 Click Finish.
When a test page is printed successfully, installation is complete.
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For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed. Click Select a shared printer by 
name and enter the path to the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it to the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, you need to specify the path to the available drivers.

4 Confirm the printer name, and then click Next.

5 Select whether to use your printer as the default printer.

6 If you want to verify installation, click Print a test page.

7 Click Finish.
When a test page is printed successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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Using the XML Paper Specification Print Driver
To use the XML Paper Specification print driver, you may need to install an additional Microsoft 
package depending on your operating system.

For further information on the XML Paper Specification print driver, visit Microsoft's web site.

Windows Vista VC++2008 Redistribution Package

Windows Server 2008 .Net Framework 3.5 SP1

Windows Server 2008 R2 .Net Framework 3.5.1 (Use the Server Manager interface to manually 
install it.)
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Installing Print Drivers on Computers Running 
Mac OS X
For information on how to install print drivers, refer to the PostScript Level3 Compatible User Guide.
This section includes:

• "Mac OS X Wireless Settings on the Operator Panel (DocuPrint P255 dw only)" on page 98
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Mac OS X Wireless Settings on the Operator Panel 
(DocuPrint P255 dw only)

You can configure wireless settings on the operator panel.

IMPORTANT: 
• The Wireless LAN feature is not available in all locations. Please check with your local Fuji Xerox 

representative for availability of wireless in your location.
• If you are using a method other than WPS to configure your wireless setting, be sure to get the SSID and 

security information from a system administrator before starting the setup procedure.
• Ensure that the Ethernet cable has been disconnected from the printer before you configure the wireless 

settings.

NOTE: 
• Before you configure the wireless settings on the operator panel, you need to set up the wireless network 

settings on your computer. For details, see the Setup Guide.
• For information on the specifications of the wireless LAN feature, see the "Configuring Wireless Network 

Settings (DocuPrint P255 dw only)" on page 62.

You can select a method to configure a wireless setting from the following:

*1 WPS-PIN is a method to authenticate and register devices required for wireless configuration, by entering PIN code in 
the printer and computer. This setting, performed through access point, is available only when the access points of your 
wireless router supports WPS.

*2 WPS-PBC is a method to authenticate and register devices required for wireless configuration, by pressing the button 
provided on the access point via wireless routers, and then performing WPS-PBC setting on the operator panel. This 
setting is available only when the access point supports WPS.

To configure wireless settings, refer to the method you selected.
• "Manual Wi-Fi Setup" on page 99
• "Auto Setup With the Access Point" on page 101

Manual Wi-Fi Setup for Access Point (Infrastructure) Network

Computer-to-computer (Ad-hoc) Network

Automatic setup using WPS-PIN*1

WPS-PBC*2
98 Printer Connection and Software Installation



Manual Wi-Fi Setup
You can manually configure wireless settings to connect your printer to an access point 
(infrastructure) network or computer-to-computer (ad-hoc) network.

• Connecting to Access Point Network
To configure the wireless settings through an access point such as a wireless router:

1 On the operator panel, press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select Wi-Fi Setup, and then press the  button.

5 Select the desired access point, and then press the  button.
If the desired access point does not appear:
a Select Manual Setup, and then press the  button.
b Enter the SSID, and then press the  button.

Use the  or  button to enter the desired value, and press the  or  button to move a 
cursor.

c Select Infrastructure, and then press the  button.
d Select an encryption type, and then press the  button.

IMPORTANT: 
• Be sure to use one of the supported encryption methods from Mixed Mode PSK, WPA-PSK-TKIP, 

WPA2-PSK-AES and WEP to protect your network traffic.

6 Enter the WEP key or pass phrase, and then press the  button.
Use the  or  button to enter the desired value, and press the  or  button to move a cursor.
When the encryption type is WEP, select a transmit key from Auto, WEP Key 1, WEP Key 2, 
WEP Key 3, and WEP Key 4 after entering the WEP key.

7 Wait a few minutes until the printer restarts to establish the wireless network.

8 Print a System Settings page from the operator panel.
a Press the  (Menu) button.
b Select Report/List, and then press the  button.
c Select System Settings, and then press the  button.

The System Settings page is printed.

9 Confirm that “Link Quality” is shown as “Good”, "Acceptable" or "Low" on the report.

NOTE: 
• When "Link Quality" is "No Reception", check if the wireless settings are correctly configured.
• If the wireless setting does not work, contact your system administrator or Fuji Xerox Customer Support 

Center.
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• Using Ad Hoc Connection
To configure the wireless settings for an ad-hoc connection where the wireless devices communicate 
directly with each other without an access point:

1 On the operator panel, press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select Wi-Fi Setup, and then press the  button.

5 Select the desired access point, and then press the  button.
If the desired access point does not appear:
a Select Manual Setup, and then press the  button.
b Enter the SSID, and then press the  button.

Use the  or  button to enter the desired value, and press the  or  button to move a 
cursor.

c Select Ad-hoc, and then press the  button.
d Select an encryption type, and then press the  button.

IMPORTANT: 
• Be sure to use one of the supported encryption methods to protect your network traffic.

6 Enter the WEP key, and then press the  button.
Use the  or  button to enter the desired value, and press the  or  button to move a cursor.

7 Select a transmit key from WEP Key 1, WEP Key 2, WEP Key 3, and WEP Key 4.

8 Wait a few minutes until the printer restarts to establish the wireless network.

9 Print a System Settings page from the operator panel.
a Press the  (Menu) button.
b Select Report/List, and then press the  button.
c Select System Settings, and then press the  button.

The System Settings page is printed.

10 Confirm that "Link Quality" is shown as "Good", "Acceptable" or "Low" on the report.

NOTE: 
• When "Link Quality" is "No Reception", check if the wireless settings are correctly configured.
• If the wireless setting does not work, contact your system administrator or Fuji Xerox Customer Support 

Center.
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Auto Setup With the Access Point
If the access point such as a wireless router supports the WPS, security settings can be made 
automatically.

• WPS-PBC
NOTE: 
• WPS-PBC is a method to authenticate and register devices required for wireless configuration, by pressing 

the button provided on the access point via wireless routers, and then performing WPS-PBC setting on the 
operator panel. This setting is available only when the access point supports WPS.

1 On the operator panel, press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select WPS Setup, and then press the  button.

5 Select Push Button Control, and then press the  button.

6 Select Start, and then press the  button.

7 Press and hold the WPS button on the access point.

8 Wait a few minutes until the printer restarts to establish the wireless network.

9 Print a System Settings page from the operator panel.
a Press the  (Menu) button.
b Select Report/List, and then press the  button.
c Select System Settings, and then press the  button.

The System Settings page is printed.

10 Confirm that "Link Quality" is shown as "Good", "Acceptable" or "Low" on the report.

NOTE: 
• When "Link Quality" is “No Reception”, check if the wireless settings are correctly configured.
• If the wireless setting does not work, contact your system administrator or Fuji Xerox Customer Support 

Center.
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• WPS-PIN
NOTE: 
• WPS-PIN is a method to authenticate and register devices required for wireless configuration, by entering PIN 

code to a printer and computer. This setting, performed through access point, is available only when the 
access points of your wireless router supports WPS.

• Before WPS-PIN starts, you will need to enter your PIN code at the web page of the wireless access point. 
See the access point manual for the details.

1 On the operator panel, press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select WPS Setup, and then press the  button.

5 Select PIN Code, and then press the  button.

6 Take a note of PIN code displayed on the operator panel.

7 Select Start Configuration, and then press the  button.

8 If SSID selection screen appears, select the SSID, and then press the  button.

9 Enter the PIN code of the printer at the web page of the wireless access point.

10 Wait a few minutes until the printer restarts to establish the wireless network.

11 Print a System Settings page from the operator panel.
a Press the  (Menu) button.
b Select Report/List, and then press the  button.
c Select System Settings, and then press the  button.

The System Settings page is printed.

12 Confirm that “Link Quality” is shown as “Good”, “Acceptable” or “Low” on the report.

NOTE: 
• When “Link Quality” is “No Reception”, check if the wireless settings are correctly configured.
• If the wireless setting does not work, contact your system administrator or Fuji Xerox Customer Support 

Center.
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Installing Print Drivers on Computers Running Linux 
(CUPS)
This section provides information on installing and setting up print drivers with CUPS (Common UNIX 
Printing System) on Red Hat® Enterprise Linux® 6 Desktop (x86), SUSE® Linux Enterprise 
Desktop 11 (x86), and Ubuntu 10 (x86). For the information on the previous versions of the Linux 
operating systems, visit respective web sites.
This section includes:

• "Installing Print Drivers" on page 104
• "Specifying the Queue" on page 105
• "Specifying the Default Queue" on page 108
• "Specifying Printing Options" on page 109
• "Setting the Password for Authority as the Printer Administrator" on page 111
• "Uninstalling Print Drivers" on page 112
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Installing Print Drivers
NOTE: 
• The print driver fx-docuprint-p255-xx-xnoar.rpm or fx-docuprint-p255_X-X_all.deb is included in the linux 

folder on the Software Pack CD-ROM.

• For Red Hat Enterprise Linux 6 Desktop (x86)

1 Double-click fx-docuprint-p255-xx-xnoar.rpm on the Software Pack CD-ROM.

2 Click Install.

3 Enter the administrator's password, and then click Authenticate.
Installation starts. When the installation is complete, the window automatically closes.

• For SUSE Linux Enterprise Desktop 11 (x86)

1 Double-click fx-docuprint-p255-xx-xnoar.rpm on the Software Pack CD-ROM.

2 Click Install.

3 Enter the administrator's password, and then click Authenticate.
Installation starts. When the installation is complete, the window automatically closes.

• For Ubuntu 10 (x86)

1 Double-click fx-docuprint-p255_X-X_all.deb on the Software Pack CD-ROM.

2 Click Install Package.

3 Enter the user password, and click OK.

4 Click Close.

5 Click the X button at the top-right of the dialog box to close the Package Installer dialog box.
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Specifying the Queue
To perform printing, you must set up the print queue on your workstation.

NOTE: 
• When you have finished specifying the queue, you can then sent print jobs from applications. Start a print job 

from an application, and specify the queue in the print dialog box. Depending on the application (Mozilla, for 
example), however, you may have to use the default queue for printing. In such a case, you must specify a 
queue you want to use as the default queue. For details on specifying the default queue, see "Specifying the 
Default Queue" on page 108.

• For Red Hat Enterprise Linux 6 Desktop (x86)

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

4 Enter root as the user name, and then enter the administrator password.

5 Click OK.

6 Select either of the following according to the type of your printer connection.
For a network printer:

a Select LPD/LPR Host or Printer from the Other Network Printers menu, and then click 
Continue.

b Enter the IP address of the printer in Connection.
Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

c Click Continue.
d Enter the name of the printer in Name in the Add Printer dialog box, and then click 

Continue.
You can optionally specify the location and description of the printer as additional 
information.

If you want to share the printer, select the Share This Printer check box.

For a USB printer connected to a computer running the Red Hat Enterprise Linux 6 Desktop 
(x86):

a Select FUJI XEROX DocuPrint P255 X (FUJI XEROX DocuPrint P255 X) from the Local 
Printers menu, and then click Continue.

b Enter the name of the printer in Name in the Add Printer dialog box, and then click 
Continue.
You can optionally specify the location and description of the printer as additional 
information.

If you want to share the printer, select the Share This Printer check box.

7 Select FX from the Make menu, and then click Continue.
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8 Select FX DocuPrint P255 xxx from the Model menu, and then click Add Printer.
The setup is complete.

You can optionally specify the default options settings of the printer.

• For SUSE Linux Enterprise Desktop 11 (x86)

1 Select Computer → More Applications..., and then select YaST on the Application Browser.

2 Enter the administrator password.
YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and then select Printer.
The Printer Configurations dialog box appears.

4 Select either of the following according to the type of your printer connection.
For a network printer:

a Click Add.
The Add New Printer Configuration dialog box appears.

b Click Connection Wizard.
The Connection Wizard dialog box appears.

c Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver 
Box via.

d Enter the IP address of the printer in IP Address or Host Name:.
e Select Fuji Xerox in Select the printer manufacturer:.
f Click OK.

The Add New Printer Configuration dialog box appears.

g Select FX DocuPrint P255 x vx.x [FujiXerox/FX-DocuPrint-P255-x.ppd.gz] from the 
Assign Driver list.

NOTE: 
• You can specify the printer name in Set Name:.
For a USB printer connected to a computer running the SUSE Linux Enterprise Desktop 11:

a Click Add.
The Add New Printer Configuration dialog box appears.

The printer name is displayed in the Determine Connection list.

b Select FX DocuPrint P255 x vx.x [FujiXerox/FX-DocuPrint-P255-x.ppd.gz] from the 
Assign Driver list.

NOTE: 
• You can specify the printer name in Set Name:.

5 Confirm the settings, and then click OK.
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• For Ubuntu 10 (x86)

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

4 Enter the User Name and the Password, and then click OK.

5 Select either of the following according to the type of your printer connection.
For a network printer:

a Select FUJI XEROX DocuPrint P255 X(XX:XX:XX) (Fuji Xerox FUJI XEROX DocuPrint 
P255 X) from Discovered Network Printer.

b Click Continue.
c Enter the name of the printer in Name in the Add Printer dialog box, and then click 

Continue.
You can optionally specify the location and description of the printer as additional 
information.

If you want to share the printer, select the Share This Printer check box.

For a USB printer connected to a computer running the Ubuntu 10 (x86):

a Select FUJI XEROX DocuPrint P255 X (FUJI XEROX DocuPrint P255 X) from the Local 
Printers menu, and then click Continue.

b Enter the name of the printer in Name in the Add Printer dialog box, and then click 
Continue.
You can optionally specify the location and description of the printer as additional 
information.

If you want to share the printer, select the Share This Printer check box.

6 Select FX from the Make menu, and then click Continue.

7 Select FX DocuPrint P255 XXX from the Model menu, and then click Add Printer.
The setup is complete.

You can optionally specify the default options settings of the printer.
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Specifying the Default Queue

• For Red Hat Enterprise Linux 6 Desktop (x86)

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window.

• For SUSE Linux Enterprise Desktop 11 (x86)

1 Select Computer → More Applications..., and then select YaST on the Application Browser.

2 Enter the administrator password.
YaST Control Center is activated.

3 Select Printer from Hardware.
The Printer Configurations dialog box appears.

4 Click Edit.
A dialog box to modify the specified queue appears.

5 Confirm that the printer you want to specify as the default queue is selected in the Connection 
list.

6 Select the Default Printer check box.

7 Confirm the settings, and then click OK.

• For Ubuntu 10 (x86)

1 Select System → Administration → Printing.

2 Select the printer you want to specify as the default queue.

3 Select the Printer menu.

4 Select Set As Default.

5 Select whether to set this printer as the system-wide default printer, and then click OK.

su

(Enter the administrator password)

lpadmin -d (Enter the queue name)
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Specifying Printing Options
You can specify printing options such as the duplex (2-sided) printing.

• For Red Hat Enterprise Linux 6 Desktop (x86)

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify printing options.

5 Click the Administration drop down box, and then select Modify Printer.

6 Specify necessary printing options, and then click Continue or Modify Printer.
The message Printer FUJI_XEROX_DocuPrint_P255_X has been modified successfully. 
appears.

The setting is complete. 

• For SUSE Linux Enterprise Desktop 11 (x86)

1 Open a web browser.

2 Enter "http://localhost:631/admin" in the address bar, and then press the Enter key.
The CUPS window appears.

NOTE: 
• Set the password for authority as the printer administrator before setting the printer queue. If you have not set 

it, see "Setting the Password for Authority as the Printer Administrator" on page 111.

3 Click Manage Printers.

4 Click Modify Printer on the printer.

5 Specify necessary printing options, and then click Continue.

6 Enter root as the user name, enter the administrator password, and then click OK.
The message Printer FUJI_XEROX_DocuPrint_P255_X has been modified successfully. 
appears.

The setting is complete.
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• For Ubuntu 10 (x86)

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify printing options.

5 Click the Administration drop down box, and then select Modify Printer.

6 Enter the User Name and the Password, and then click OK.

7 Select the printer you want to modify.

8 Specify necessary printing options, and then click Continue or Modify Printer.
The message Printer FUJI_XEROX_DocuPrint_P255_X has been modified successfully. 
appears.

The setting is complete.
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Setting the Password for Authority as the Printer 
Administrator

For SUSE Linux Enterprise Desktop 10 and 11, you must set the password for authority as the printer 
administrator to do operations as the printer administrator.

• For SUSE Linux Enterprise Desktop 11 (x86)

1 Select Computer → More Applications... and select GNOME Terminal on the Application 
Browser.

2 Enter the following command in the terminal window.

su

lppasswd -g sys -a root

(Enter the password for authority as the printer 
administrator after the Enter password prompt.)

(Reenter the password for authority as the 
printer administrator after the Enter password 
again prompt.)
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Uninstalling Print Drivers

• For Red Hat Enterprise Linux 6 Desktop (x86)

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

• For SUSE Linux Enterprise Desktop 11 (x86)

1 Select Computer → More Applications... and select GNOME Terminal on the Application 
Browser.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

lpadmin -x (Enter the print queue name)

rpm -e FX-DocuPrint-P255

su

lpadmin -x (Enter the print queue name)

rpm -e FX-DocuPrint-P255
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• For Ubuntu 10 (x86)

1 Select Applications → Accessories → Terminal.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

sudo lpadmin -x (Enter the print queue name)

(Enter the user password)

sudo dpkg -r fx-docuprint-p255

(Enter the user password if required)
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5
Printing Basics

This chapter includes:
• "About Print Media" on page 116
• "Supported Print Media" on page 118
• "Loading Print Media" on page 125
• "Setting Paper Sizes and Types" on page 140
• "Printing" on page 141
• "Printing with the Web Services on Devices" on page 159
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About Print Media
Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or 
printer failures. To achieve the best performance from your printer, we recommend you use only the 
paper described in this section.
When using paper other than that recommended, contact our local representative office or authorized 
dealer.
This section includes:

• "Print Media Usage Guidelines" on page 116
• "Print Media That Can Damage Your Printer" on page 117
• "Print Media Storage Guidelines" on page 117

Print Media Usage Guidelines
The paper tray accommodates various sizes and types of paper and other specialty media. Follow 
these guidelines when loading paper and media:

• Before buying large quantities of any print media, it is recommended that you try a sample first.
• For 60 to 135 gsm (16 to 36 lb bond) paper, grain long, where the paper fibers run along the 

length of the paper, is recommended. For paper heavier than 135 gsm (36 lb bond), grain short, 
where the paper fibers run along the width of the paper, is preferred.

• Envelopes can be printed from the paper tray and the Priority Sheet Inserter (PSI).
• Fan paper or other specialty media before loading in the paper tray.
• Do not print on label stock once a label has been removed from a sheet.
• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with 

release strips.
• Print all envelopes single-sided only. 
• Some wrinkling and embossing may occur when printing envelopes.
• When loading print media in the paper tray, do not load it above the fill line on the paper width 

guides of the paper tray.
• Slide the paper width guides to adjust to the paper size.
• If excessive jams or wrinkles occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Paper Tray" on page 126
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134
• "Loading Envelopes in the Paper Tray" on page 130
• "Loading Envelopes in the Priority Sheet Inserter (PSI)" on page 137
• "Printing on Custom Size Paper" on page 154

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media That Can Damage Your Printer
Your printer is designed to use a variety of media types for print jobs. However, some media can 
cause poor output quality, excessive paper jams, or damage to your printer.
Unacceptable media includes:

• Rough or porous media
• Plastic media
• Paper that has been folded or wrinkled
• Paper with staples
• Envelopes with windows or metal clasps
• Padded envelopes
• Non-laser glossy or coated paper
• Perforated media

Print Media Storage Guidelines
Providing good storage conditions for your paper and other media contributes to optimum print quality.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to 
damage from ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and 
fluorescent bulbs, is particularly damaging to paper items. The intensity and length of exposure 
to visible light on paper items should be reduced as much as possible.

• Maintain constant temperatures and relative humidity.
• Avoid attics, kitchens, garages, and basements for storing print media. 
• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.
• Avoid having food or drinks in the area where print media is stored or handled.
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

paper in the original packaging. For most commercial cut-size grades, the ream wrapper 
contains an inner lining that protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag 
and reseal it for protection. Some specialty media is packaged inside resealable plastic bags. 

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Supported Print Media
Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to 
your printer. To use the features of your printer effectively, use the suggested print media that is 
recommended here.

IMPORTANT: 
• The toner may come off the print media, if it gets wet by water, rain, steam and so on. For more information, 

contact our local representative office or authorized dealer.
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Usable Print Media
The types of print media that can be used on your printer are as follows:

Paper Tray

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Legal 13 (Folio) SEF (8.5 × 13 inches)

Legal 14 SEF (8.5 × 14 inches)

Statement SEF (139.7 × 215.9 mm)

Com-10 Envelope SEF (4.125 × 9.5 inches)

Monarch Envelope SEF (3.875 × 7.5 inches)

Monarch Envelope LEF (7.5 × 3.875 inches)*

DL Envelope SEF (110 × 220 mm)

DL Envelope LEF (220 × 110 mm)*

C5 Envelope SEF (162 × 229 mm)

Postcard (100 × 148 mm)

Postcard (148 × 200 mm)

Yougata 2 Envelope SEF (114 × 162 mm)

Yougata 2 Envelope LEF (162 × 114 mm)*

Yougata 3 Envelope SEF (98 × 148 mm)

Yougata 3 Envelope LEF (148 × 98 mm)*

Yougata 4 Envelope (105 × 235 mm)

Yougata 6 Envelope (98 × 190 mm)

Younaga 3 Envelope (120 × 235 mm)

Nagagata 3 Envelope (120 × 235 mm)

Nagagata 4 Envelope (90 × 205 mm)

Kakugata 3 Envelope (216 × 277 mm)

Custom size:
Width: 76.2 - 215.9 mm (3 - 8.5 inches)
Length: 127 - 355.6 mm (5 - 14 inches)

Paper Type Plain (60 - 105 gsm)

Lightweight Cardstock (106 - 163 gsm)

Labels

Envelope

Recycled

Postcard JPN

Loading Capacity 250 sheets of standard paper
* You can load Monarch, DL, Yougata 2, and Yougata 3 envelopes in the LEF orientation into the paper tray 

with the flap unfolded.
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Priority Sheet Inserter (PSI)

NOTE: 
• SEF and LEF indicate the paper feed orientation; SEF stands for short-edge feed. LEF stands for long-edge 

feed.
• Use only laser print media. Do not use ink jet paper on your printer.

See also: 
• "Loading Print Media in the Paper Tray" on page 126
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134
• "Loading Envelopes in the Paper Tray" on page 130
• "Loading Envelopes in the Priority Sheet Inserter (PSI)" on page 137

Printing on print media that differs from the paper size or paper type selected on the print driver may 
lead to paper jams. To ensure that printing is correctly done, select the correct paper size and paper 
type.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Legal 13 (Folio) SEF (8.5 × 13 inches)

Legal 14 SEF (8.5 × 14 inches)

Statement SEF (139.7 × 215.9 mm)

Com-10 Envelope SEF (4.125 × 9.5 inches)

DL Envelope SEF (110 × 220 mm)

C5 Envelope SEF (162 × 229 mm)

Yougata 4 Envelope (105 × 235 mm)

Younaga 3 Envelope (120 × 235 mm)

Nagagata 3 Envelope (120 × 235 mm)

Kakugata 3 Envelope (216 × 277 mm)

Custom size:
Width: 76.2 - 215.9 mm (3.0 - 8.5 inches)
Length: 210 - 355.6 mm (8.2 - 14 inches)

Paper Type Plain (60 - 105 gsm)

Lightweight Cardstock (106 - 163 gsm)

Labels

Envelope

Recycled

Postcard JPN

Loading Capacity 10 sheets for plain paper or one sheet for other paper
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Standard Paper and Tested Paper
The following paper and media are standard or usable for the printer.
When you print a generally used paper (which called general paper), please use a paper that suits the 
standard. To print clearly, we recommend the standard paper shown in the following table. For 
information about the other paper and media, contact Fuji Xerox Customer Support Center.

Paper Name Size Weight Paper Type Notes
Standard 
Paper

FX P A4 64 gsm Recycled Medium-thickness paper 
for in-house documents 
and general office use.

XC Premier 80 A4 80 gsm Plain

Colotech +90 A4 90 gsm Plain

Business 4200 Letter 20 lb Plain

Supported 
Paper

Business 4200 Legal 20 lb Plain

Cascade X-9000 Folio Plain

Cascade X-9000 Letter Plain

Hammermill Tidal MP Letter Plain

Hammermill Fore MP Legal 24 lb Plain

Business 4200 Letter Plain

Hammermill Laser 
Print

Letter Plain

Color Xpressions 
Select

Letter Plain

GP Laser1000 Executive Plain

Color Xpressions Elite Letter 28 lb Plain

Business 4200 Letter Plain

FX P B5 64 gsm Recycled Medium-thickness paper 
for in-house documents 
and general office use.

FX P A5 Recycled

FX FR A4 Recycled Environmentally-
conscious paper (50% of 
pulp sourced from 
plantation-grown trees + 
50% of recycled pulp).

V-Paper A4 Recycled

Oji-Recycle 100 B5 66 gsm Recycled

Oji-Recycle 100 A4 Recycled

V-paper MG A4 67 gsm Recycled

FX G70 A4 Recycled Recycled copy/printer 
paper compounded 70% 
of recycled pulp.

FX G100 A4 Recycled
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Supported 
Paper 
(Cont’d)

FX C2 A5 70 gsm Recycled Paper for general office 
use with minimum see-
through.

FX C2R A4 Recycled 70% recycled pulp 
paper.

XC Premier 80 A5 80 gsm Plain

XC Business 80 A4 Plain

Data Copy A4 Plain

Steinbeis Recycling 
Copy

A4 Plain

Yes Bronze A4 Plain

Berga Focus A4 Plain

XC Premier 90 A4 90 gsm Plain

Conqueror Laid laser 
Paper

A4 Plain

FX JD B5 98 gsm Plain Double-sided paper 
suitable for a variety of 
uses, including 
brochures and booklet.

FX JD A4 Plain

Multicopy Nymolla A4 100 gsm Plain

Special 
Paper

FX Label (No Cut) A4 Label Labels

FX Label (20 Cut) A4 Labels

Xerox Label (No Cut) A4 Labels

Xerox Label (24 Cut) A4 Labels

Avery Labels 5165 
(No Cut)

Letter Labels

Avery Labels 5160 
(30 Cut)

Letter Labels

Columbia CO125 Com-10 Envelope Envelope

Print Master Monarch Envelope

River Series DL Envelope

Autofill 90 gsm DL Envelope

River Series C5 Envelope

Autofill 90 gsm C5 Envelope

Heart Hatsushiba Yougata 2 Envelope

Heart Hatsushiba Yougata 3 Envelope

Heart Hatsushiba Yougata 4 Envelope

Heart Hatsushiba Yougata 6 Envelope

Heart Tokushiro 80 Nagagata 3 Envelope

Heart Tokushiro 81 Nagagata 4 Envelope

Heart Tokushiro 82 Kakugata 3 Envelope

Paper Name Size Weight Paper Type Notes
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Special 
Paper 
(Cont’d)

Official Postcard Japanese 
Postcard

Postcard 
190 gsm

Postcard JPN IMPORTANT: 
• Do not use a special 

ink jet printer 
postcard. It can 
cause the printer 
failure.

Official Postcard Reply-paid 
Postcard

Postcard JPN

Esselte Oxford Index 
Card

3 x 5 inches - Lightweight 
Cardstock

Xerox Color 
Xpressions Elite

Letter 120 gsm Lightweight 
Cardstock

OK Prince 127 A4 128 gsm Lightweight 
Cardstock

Shiraoi A4 156 gsm Lightweight 
Cardstock

OK Prince 157 A4 157 gsm Lightweight 
Cardstock

Premier TCF 160 A4 160 gsm Lightweight 
Cardstock

IBG Paper PFX V704 A4 70 gsm Plain

FXCL Xplore A4 Plain

FXCL Xcellence 70 A4 Plain

FXCL Xceed 70 A4 Plain

Topgun A4 Plain

OAHING PAPER A4 Plain

UPM Office 
Multifunction

A4 Plain

AG Docupaper Folio Plain

FXK A704 A4 75 gsm Plain

FXK K704A A4 Plain

Paper Name Size Weight Paper Type Notes
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IBG Paper 
(Cont’d)

PFX Red & White 
Packaging

A4 80 gsm Plain

FXA Professional A4 Plain

FXCL Xcite A4 Plain

FXCL Xcellence 80 A4 Plain

FXCL Xceed 80 A4 Plain

Double A Laser Paper A4 Plain

KX H-Paper A4 Plain

Green Member A4 Plain

BIO TOP 3 Extra A4 Plain

AG Red Label Folio Plain

THFX Paper-Q 
Advance Argo

A4 Plain

FXM Diplomat A4 Plain

FXM Excel A4 Plain

FXM Xerox One A4 Plain

FXA Colotech Idol 
80 gsm

A4 Plain

FXA Colotech Idol 
100 gsm

A4 100 gsm Plain

Colotech Plus 120 
gsm

A4 120 gsm Lightweight 
Cardstock

FXM Label 16up A4 140 gsm Labels

FXM Label 8up A4 Labels

Paper Name Size Weight Paper Type Notes
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Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.
Before loading print media, identify the recommended print side of the print media. This information is 
usually on the print media package.

NOTE: 
• After loading paper in the paper tray or the Priority Sheet Inserter (PSI), specify the same paper type on the 

operator panel.

Capacity
The paper tray can accommodate:

• 250 sheets of standard paper
• 27.5 mm (1.08 inches) of thick paper
• 27.5 mm (1.08 inches) of postcards
• 10 envelopes
• 20 labels

The Priority Sheet Inserter (PSI) can accommodate:
• 10 sheets for plain paper or one sheet for other paper

Print Media Dimensions
The paper tray can accommodate print media within the following dimensions: 

• Width: 76.2 - 215.9 mm (3.00 - 8.50 inches)
• Length: 127.0 - 355.6 mm (5.00 - 14.00 inches)

The Priority Sheet Inserter (PSI) can accommodate print media within the following dimensions: 
• Width: 76.2 - 215.9 mm (3.00 - 8.50 inches)
• Length: 210.0 - 355.6 mm (8.20 - 14.00 inches)
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Loading Print Media in the Paper Tray
NOTE: 
• When you are printing on any print media that is smaller than the A5 size paper, be sure to load it in the paper 

tray.
• To avoid paper jams, do not remove the paper tray while printing is in progress.
• Use only laser print media. Do not use ink jet paper on your printer.
• For manually loading print media for duplex (2-sided) printing, see "Manual Duplex Printing (PCL Print Driver 

Only)" on page 144.
• Do not wipe the pink-tinted grease off as doing so may cause paper to misfeed.

1 Pull the paper tray out of the printer about 200 mm. Hold the tray with both hands, remove it from 
the printer, and then remove the paper tray cover from the paper tray.
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2 Hold the paper tray end with one hand, push and hold the paper tray extension lever with the 
other hand, and then extend the tray to your desired length.

NOTE: 
• The paper tray can accommodate a stack of A5 paper by default, and is designed to extend in two 

lengths. To load A4 paper media, extend the paper tray to the mid length. To load longer paper media, 
extend it to the full length.

3 Slide the paper width guides and the length guide to the maximum positions.

4 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.
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5 Load the print media into the paper tray with the recommended print surface facing up.

NOTE: 
• Do not load paper media above the fill line on the paper width guides of the paper tray as it may cause 

paper jams.

6 Slide the paper width guides and then the length guide inward until they rest lightly against the 
edges of the print media stack.

7 Replace the paper tray cover onto the paper tray.

8 Hold the paper tray with both hands and push it into the printer until it clicks into place.
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9 Open the output tray extension.

10 Select the paper type on the print driver if the loaded print media is not standard plain paper. If a 
user-specified print media is loaded in the paper tray, you must specify the paper size on the print 
driver.

NOTE: 
• For details on specifying the paper size and type on the print driver, refer to the Help provided for the print 

driver.
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Loading Envelopes in the Paper Tray
Follow the guidelines below to load envelopes in the paper tray.

NOTE: 
• When you print on envelopes, be sure to specify the envelope on the print driver. If not specified, the print 

image will be rotated 180 degrees.
• If you do not load envelopes in the paper tray right after they have been removed from the packaging, they 

may bulge. To avoid jams, flatten them as shown below before loading them in the paper tray.

• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration. The amount of the bending shall be 5 mm (0.20 inches) or less.

IMPORTANT: 
• Never use envelopes with a window or coated linings as it causes paper jams that may result in damage to the 

printer.
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• Loading Com-10, Yougata 4/6, or Younaga 3 Envelopes
Load envelopes with the print surface facing up. Ensure that the flapped edge is pointing toward the 
right of the printer and each flap is folded under the envelope.

• Loading Monarch, DL, or Yougata 2/3 Envelopes
You can load Monarch, DL, and Yougata 2/3 Envelopes in either of the following orientations:
SEF: Load envelopes with the print surface facing up. Ensure that the flapped edge is pointing toward 
the right of the printer and each flap is folded under the envelope.

LEF: Load envelopes with the print surface facing up. Ensure that the flapped edge is pointing toward 
the front of the printer and the flaps are left unfolded.

NOTE: 
• When you load the envelopes in the LEF orientation, be sure to specify the landscape orientation on the print 

driver.
• To confirm the correct orientation of each print media such as envelopes, see the instructions on the 

Envelope/Paper Setup Navigator dialog box of the print driver.

• Loading C5, Nagagata 3/4, or Kakugata 3 Envelopes
Load envelopes with the print surface facing up. Ensure that the flapped edge is pointing toward the 
rear of the printer and each flap is folded under the envelope.
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Loading Postcards in the Paper Tray
NOTE: 
• When you print on postcards, be sure to specify the postcard on the print driver for the optimum print result.
• Before loading postcards, smooth them out, but bend the leading edge as shown in the following illustration. 

Bend them about 5 mm (0.20 inches).

• Loading Postcards
Load postcards with the print surface facing up and the top edge first.
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• Loading W-Postcards
Load W-postcards with the print surface facing up and the left edge first.

NOTE: 
• To confirm the correct orientation of each print media such as postcards, see the instructions on the 

Envelope/Paper Setup Navigator dialog box of the print driver.
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Loading Print Media in the Priority Sheet Inserter (PSI)
NOTE: 
• Before you use the Priority Sheet Inserter (PSI), make sure that the printer has the paper tray inserted.
• Use only laser print media. Do not use ink jet paper on your printer.
• For manually loading print media for duplex (2-sided) printing, see "Manual Duplex Printing (PCL Print Driver 

Only)" on page 144.

1 Open the front cover.

2 Slide the paper width guides to the maximum positions.

3 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.
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If print media are still not fed correctly, add some bending to the leading edge of the print media 
as shown in the following illustration. The amount of the bending shall be 5 mm (0.20 inches) or 
less.
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4 Load print media in the PSI with the top edge first and the recommended print surface facing up.

5 Slide the paper width guides inward until they rest lightly against the edges of the print media 
stack.

6 Open the output tray extension.

7 Select the paper type on the print driver if the loaded print media is not plain paper. If a user-
specified print media is loaded in the PSI, you must specify the paper size on the print driver.

NOTE: 
• For details on specifying the paper size and type on the print driver, refer to the Help provided for the print 

driver.
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Loading Envelopes in the Priority Sheet Inserter (PSI)
Follow the guidelines below to load envelopes in the PSI.

NOTE: 
• Be sure to insert envelopes all the way in. Otherwise, print media that is loaded in the paper tray will be fed.
• When you print on envelopes, be sure to specify the envelope on the print driver. If not specified, the print 

image will be rotated 180 degrees.
• If you do not load envelopes in the PSI right after they have been removed from the packaging, they may 

bulge. To avoid jams, flatten them as shown below before loading them in the PSI.

• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration. The amount of the bending shall be 5 mm (0.20 inches) or less.

IMPORTANT: 
• Never use envelopes with a window or coated linings as it causes paper jams that may result in damage to the 

printer.
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• Loading Com-10, DL, Yougata 4, or Younaga 3 Envelopes
Load envelopes with the print surface facing up. Ensure that the flapped edge is pointing toward the 
right of the printer and each flap is folded under the envelope.

• Loading C5, Nagagata 3, or Kakugata 3 Envelopes
Load envelopes with the print surface facing up. Ensure that the flapped edge is pointing toward the 
front of the printer and the flaps are left unfolded.
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Using the Output Tray Extension
The output tray extension is designed to prevent print media from falling from the printer after the print 
job is complete.
Before printing a long length document, be sure to open the output tray extension.
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Setting Paper Sizes and Types
When loading print media, set the paper size and type on the operator panel before printing. 
This section describes how to set the paper size and type on the operator panel.

See also: 
• "Understanding the Operator Panel Menus" on page 162

This section includes:
• "Setting Paper Sizes" on page 140
• "Setting Paper Types" on page 140

Setting Paper Sizes
1 Press the  (Menu) button.

2 Select Tray Settings, and then press the  button.

3 Select Tray, and then press the  button.

4 Select Paper Size, and then press the  button.

5 Select the correct paper size for the print media loaded, and then press the  button.

Setting Paper Types
IMPORTANT: 
• The paper type must match those of the actual print media loaded in the paper tray. Otherwise, print-quality 

problems can occur.

1 Press the  (Menu) button.

2 Select Tray Settings, and then press the  button.

3 Select Tray, and then press the  button.

4 Select Paper Type, and then press the  button.

5 Select the correct paper type for the print media loaded, and then press the  button.
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Printing
This section covers how to print documents from your printer and how to cancel a job.
This section includes:

• "Printing from the Computer" on page 141
• "Canceling a Print Job" on page 142
• "Duplex Printing" on page 143
• "Selecting Printing Options" on page 148
• "Printing Custom Size Paper" on page 153
• "Checking Status of a Print Job" on page 155
• "Printing a Report Page" on page 156
• "Printer Settings" on page 157

Printing from the Computer
Install the print driver to use all the features of the printer. When you choose Print from an application, 
a window representing the print driver appears. Select the appropriate settings for the file to print. Print 
settings selected on the print driver have precedence over the default menu settings selected on the 
operator panel or the Printer Setting Utility.
The following procedure uses Windows 7 WordPad as an example.
Clicking Preferences on the initial Print dialog box enables you to change the print settings. If you are 
not familiar with features on the print driver window, open the Help for additional information.

1 Open the file you want to print.

2 From the file menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the print settings as needed 
(such as the pages you want to print or the number of copies).

4 To adjust print settings not available from the first screen, such as Paper Size, Paper Type, or 
Feed Orientation, click Preferences.
The Printing Preferences dialog box appears.

5 Specify the print settings. For more information, click Help.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print to send the job to the selected printer.
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Canceling a Print Job
There are several methods for canceling a print job.
This section includes:

• "Canceling a Job From the Operator Panel" on page 142
• "Canceling a Job From the Computer (Windows)" on page 142

Canceling a Job From the Operator Panel

1 Press the  (Cancel Job) button.

NOTE: 
• Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From the Computer (Windows)

• Canceling a Job From the Taskbar
When you send a print job, a small printer icon appears on the taskbar.

1 Double-click the printer icon. 
A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press the Delete key.

4 Click Yes on the Printers dialog box to cancel a print job.

• Canceling a Job From the Desktop

1 Minimize all programs to reveal the desktop.
Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista and 
Windows Server 2008).

A list of available printers appears. 

2 Double-click the printer you selected when you sent the job.
A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press the Delete key.

5 Click Yes on the Printers dialog box to cancel a print job.
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Duplex Printing
Duplex (2-sided) printing allows you to print on either side of a sheet of paper. The paper sizes 
available for duplex printing are A4, B5, A5, Letter, Executive, Folio, and Legal.
This section includes:

• "Automatic Duplex Printing" on page 143
• "Manual Duplex Printing (PCL Print Driver Only)" on page 144

Automatic Duplex Printing
The following procedure uses the PCL 6 driver as an example.

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the icon for your printer and select Printing preferences.
The Paper/Output tab appears.

3 From Duplex, select Flip on Long Edge or Flip on Short Edge.

4 Click OK.
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Manual Duplex Printing (PCL Print Driver Only)
When you have a problem with automatic duplex printing, you may want to try manual duplex printing. 
Starting manual duplex printing displays a window containing the instructions that you can follow. Note 
that the window cannot be reopened once it is closed. Do not close the window until duplex printing is 
complete.

NOTE: 
• When printing on curled paper, straighten the paper before inserting the paper.

• Operations on Your Computer
The following procedure uses Microsoft Windows 7 WordPad as an example.

NOTE: 
• The way to display the Printer Properties/Printing Preferences dialog box depends on the application 

software. Refer to the manual of your application software.

1 From the file menu, select Print.

2 Select the printer from the Select Printer list box, and then click Preferences.
The Paper/Output tab of the Printing Preferences dialog box appears.

3 From Duplex, select either Flip on Short Edge (Manual) or Flip on Long Edge (Manual) to 
define the way 2-sided print pages are bound. 

4 From Paper Size, select the size of the document to be printed.

5 From Paper Type, select the paper type to be used.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print in the Print dialog box to start printing.

3

4

5
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• Loading Print Media in the Paper Tray

1 First print the even pages (rear sides).
For a six page document, rear sides are printed in the order of page 6, page 4, then page 2.

When printing of the even pages is complete, the  (Ready) LED lights and the LCD panel 
shows the following:

2 After the even pages are printed, pull out the paper tray and remove the paper tray cover.

See also: 
• "Loading Print Media in the Paper Tray" on page 145

3 Remove the paper stack from the center output tray and load it into the paper tray with the blank 
surface facing up.

NOTE: 
• Warped or curled prints can cause paper jams. Straighten them before setting them.

Insert Output

and Press OK
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4 Replace the paper tray cover, insert the paper tray into the printer, and then press the  button.
Pages are printed in the order of page 1 (rear of page 2), page 3 (rear of page 4), and then page 
5 (rear of page 6).
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• Loading Print Media in the Priority Sheet Inserter (PSI)

1 First print the even pages (rear sides).
For a six page document, rear sides are printed in the order of page 6, page 4, then page 2.

When printing of the even pages is complete, the  (Ready) LED lights and the LCD panel 
shows the following:

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 
• Warped or curled prints can cause paper jams. Straighten them before setting them.

3 Load the paper stack back into the PSI, and then press the  button.
Pages are printed in order of page 1 (rear of page 2), page 3 (rear of page 4), and then page 5 
(rear of page 6).

Insert Output

and Press OK
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Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 148
• "Selecting Options for an Individual Job (Windows)" on page 148
• "Selecting Options for an Individual Job (Mac OS X)" on page 151

Selecting Printing Preferences (Windows)
Printing preferences control all of your print jobs, unless you override them specifically for a job. For 
example, if you want to use duplex (2-sided) printing for most jobs, set this option in printing 
preferences.

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista and 
Windows Server 2008).

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing preferences.
The printer’s Printing Preferences dialog box appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 
• For details on Windows print driver options, click Help on the print driver tab to view the Help.

Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before 
sending the job to the printer. For example, if you want to use Photo print-quality mode for a particular 
graphic, select this setting on the print driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select your printer and click Preferences to open the print driver.

3 Make selections on the driver tabs.

NOTE: 
• On Windows, you can save current printing options with a distinctive name and apply them to other print 

jobs. Make selections on the Paper/Output, Graphics, Layout, Watermarks/Forms, or Advanced tab, 
and then click Save under Favorites on the Paper/Output tab. Click Help for more information.

4 Click OK to save your selections.

5 Print the job.
See the following table for specific printing options:
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Printing Options for Windows

Operating System Driver Tab Printing Options
Windows XP, 

Windows XP x 64bit, 

Windows Server 2003, 

Windows Server 2003 x 
64bit, 

Windows Vista, 

Windows Vista x 64bit, 

Windows Server 2008, 

Windows Server 2008 x 
64bit, 

Windows Server 2008 R2, 

Windows 7, or 

Windows 7 x 64bit

Paper/Output tab • Favorites
• Duplex
• Copies
• Collated
• Paper Summary
• Paper Size
• Paper Type
• Feed Orientation
• Envelope/Paper Setup Navigator
• Printer Status
• Restore Defaults

Graphics tab • Image Quality
• Toner Saving Mode
• Image Enhancement
• Screen
• Image Settings

– Apply to All Elements
– Apply to Selected Element
– Brightness
– Contrast

• Tone Balance
• Restore Defaults

Layout tab • Image Orientation
• Multiple Up
• Image Order
• Image Border
• Booklet / Poster / Mixed Document
• Output Size
• Reduce / Enlarge
• Margin Shift/Margin
• Restore Defaults
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Windows XP, 

Windows XP x 64bit, 

Windows Server 2003, 

Windows Server 2003 x 
64bit, 

Windows Vista, 

Windows Vista x 64bit, 

Windows Server 2008, 

Windows Server 2008 x 
64bit, 

Windows Server 2008 R2, 

Windows 7, or 

Windows 7 x 64bit

Watermarks/Forms tab • Watermarks
– New Text
– New Bitmap
– Edit
– Delete
– First Page Only

• Forms
– Off
– Create / Register Forms
– Image Overlay

• Header / Footer Options
• Restore Defaults

Advanced tab • Items
– Change All Colors to Black
– Resolution
– Show Paper Size/Type Error

• Font Settings
• Restore Defaults

Operating System Driver Tab Printing Options
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the 
printer.

1 With the document open in your application, click File, and then click Print.

2 Select your printer from Printer.

3 Select the desired printing options from the menus and drop-down lists that are displayed.

NOTE: 
• On Mac OS X, click Save As on the Presets menu screen to save the current printer settings. You can 

create multiple presets and save each with its own distinctive name and printer settings. To print jobs 
using specific printer settings, click the applicable saved preset in the Presets menu.

4 Click Print to print the job.
Mac OS X Print Driver Printing Options:
The table shown below uses Mac OS X 10.6 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options
• Copies
• Collated
• Pages
• Paper Size
• Orientation

Layout • Pages per Sheet
• Layout Direction
• Border
• Two-Sided
• Reverse page orientation
• Flip horizontally

Color Matching • ColorSync
• In printer
• Profile

Paper Handling • Pages to Print
• Page Order
• Scale to fit paper size
• Destination Paper Size
• Scale down only

Cover Page • Print Cover Page
• Cover Page Type
• Billing Info

Scheduler • Print Document
• Priority
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Printer Features • 1. Detailed Settings
– Resolution
– Screen
– Toner Saving Mode
– Image Enhancement

• 2. Paper Handling
– Duplex
– Paper Type
– Show Paper Size/Type Error

Summary

Item Printing Options
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Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.
The way to load custom size paper is the same as the one to load standard size paper.
• "Loading Print Media in the Paper Tray" on page 126
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134
• "Setting Paper Sizes and Types" on page 140

Defining a Custom Paper Size
Before printing, define a custom size on the print driver.

NOTE: 
• When defining a paper size on the print driver or the operator panel, be sure to specify the same size as the 

actual print media used. Specifying a wrong size for printing can cause a printer failure. This is especially true 
if you specify a bigger size when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, define a custom size in the Custom Paper Size dialog box. This section 
explains the procedure using Windows 7 as an example.
On Windows XP or later, only users with administrator rights can use the administrator's password to 
change the settings. Users without the rights of administrator can only view the contents.

1 Click Start → Devices and Printers.

2 Right-click the icon for your printer, and then select Printer properties.

3 Select the Configuration tab.

4 Click Custom Paper Size.

5 Select the custom setup you want to define from Details.

6 Specify the length of the short edge and long edge under Change Setting For. You can specify 
the values either by entering them directly or using the up arrow and down arrow buttons. The 
length of the short edge cannot be longer than the long edge, even if it is within the specified 
range. The length of the long edge cannot be shorter than the short edge, even if it is within the 
specified range.

7 To assign a paper name, select the Name the Paper Size check box, and then enter the name in 
Paper Name. Up to 14 characters can be used for the paper name.

8 If necessary, repeat steps 5 to 7 to define another custom size.

9 Click OK twice.
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Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print driver.

• Using the Windows Print Driver
This section explains the procedure using Windows 7 WordPad as an example.

NOTE: 
• The way to display the Printer Properties/Printing Preferences dialog box depends on the application 

software. Refer to the manual of your application software.

1 From the file menu, select Print.

2 Select your printer and click Preferences.

3 Select the Paper/Output tab.

4 Select the size of the document to be printed from Paper Size.

5 Select the paper type to be used from Paper Type.

6 Click the Layout tab.

7 From Output Size, select the custom size you defined. If you have selected the custom size from 
Paper Size in step 4, select Same as Paper Size.

8 Click OK.

9 Click Print in the Print dialog box to start printing.

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.6 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select your printer from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.
A newly created setting Untitled is displayed in the list.

5 Double-click Untitled and enter a name for the setting.

6 Enter the size of the document to be printed in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Click Print to start printing.
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Checking Status of a Print Job
This section includes:

• "Checking Status (Windows Only)" on page 155
• "Checking Status on the CentreWare Internet Services (Windows & Mac OS X)" on page 155

Checking Status (Windows Only)
You can check the printer status with the SimpleMonitor. Double-click the SimpleMonitor printer icon 
on the taskbar at the bottom right of the screen. The Printer Selection window appears and displays 
the printer name, the printer connection port, printer status, and the model name. Check the column 
Status for the current status of your printer. 
Settings button: Displays the Settings window and allows you to modify the SimpleMonitor settings.
Click the name of the desired printer listed on the Printer Selection window. The Printer Status 
window appears. You can check the printer status and print job status.
For details on the SimpleMonitor, see Help. The following procedure uses Windows 7 as an example:

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → SimpleMonitor-Btype for Asia-Pacific.
The Printer Selection window appears.

2 Click the name of the desired printer from the list.
The Printer Status window appears.

3 Click Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 43

Checking Status on the CentreWare Internet Services (Windows & 
Mac OS X)
You can check the status of the print job sent to the printer on the Jobs tab of the CentreWare Internet 
Services.

See also: 
• "Printer Management Software" on page 39
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Printing a Report Page
You can print various types of reports and lists. For details on each report and list, see "Report/List" on 
page 163.
Taking the System Settings page as an example, this section describes two methods of printing a 
report page.

Printing the System Settings Page
To verify detailed printer settings, print the System Settings page.

• Using the Operator Panel
NOTE: 
• The reports and lists are all printed in English.

1 Press the  (Menu) button.

2 Select Report/List, and then press the  button.

3 Select System Settings, and then press the  button.
The System Settings page is printed.

• Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

NOTE: 
• The reports and lists are all printed in English.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 
• The window to select a printer appears in this step when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility starts.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.
The Reports page is displayed.

4 Click the System Settings button.
The System Settings page is printed.
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Printer Settings
You can change the printer settings using either the operator panel or the Printer Setting Utility.

Changing the Printer Settings

• Using the Operator Panel
NOTE: 
• Factory defaults may vary for different regions.
• Once one value is selected, it will be active until a new value is applied or the default value is restored.
• Driver settings may have precedence over the changes previously made and you may have to change the 

printer settings.

1 Press the  (Menu) button.

2 Select the desired menu, and then press the  button.

3 Select the desired menu or menu item, and then press the  button.
• If the selection is a menu, the menu opens and the list of menu items appears.
• If the selection is a menu item, the default menu setting appears.
A value can be:

• A phrase or word to describe a setting
• A numerical value that can be changed
• An On or Off setting

4 Repeat step 3 until you reach the desired value.

5 Press the  button to apply the selected value.

6 To continue changing the printer settings, use the  (Back) button to ascend the operator panel 
menus to one of the top menus and follow steps 2 through 5.
To quit changing the printer settings, keep pressing the  (Back) button until the LCD panel 
shows Ready to Print.
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• Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

NOTE: 
• Once one value is selected, it will be active until a new value is applied or the default value is restored.
• Driver settings may have precedence over the changes previously made and you may have to change the 

printer settings.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 
• The window to select a printer appears in this step when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility starts.

2 Click the Printer Maintenance tab.

3 Select the desired menu item.
Each menu item has a list of values. A value can be:

• A phrase or word to describe a setting
• A numerical value that can be changed
• An On or Off setting

4 Select the desired value, and then click the Apply New Settings or Restart printer to apply 
new settings button.
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Printing with the Web Services on Devices
This section provides information for network printing with the Web Services on Devices available on 
Windows Vista, Windows Server 2008, Windows Server 2008 R2, and Windows 7 protocol of 
Microsoft.
This section includes:

• "Adding Roles of Print Services" on page 159
• "Printer Setup" on page 160

Adding Roles of Print Services
When you use Windows Server 2008 or Windows Server 2008 R2, you need to add the roles of print 
services to the Windows Server 2008 or Windows Server 2008 R2 client.

• For Windows Server 2008:

1 Click Start → Administrative Tools → Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and 
then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print and Document Services check box on the Server Roles window in the Add 
Roles Wizard, and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.
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Printer Setup
You can install your new printer on the network using the Software Pack CD-ROM that shipped with 
your printer, or using Add Printer Wizard.

Installing a Print Driver Using the Add Printer Wizard

1 Click Start → Control Panel → Hardware and Sound → Printers (Start → Devices and 
Printers for Windows Server 2008 R2 and Windows 7).

2 Click Add a printer to launch the Add Printer Wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 
• In the list of available printers, the Web Services on Devices printer is displayed in the form of "http://IP 

address/ws/". 
• If no Web Services on Devices printer is displayed in the list, enter the printer's IP address manually to 

create a Web Services on Devices printer. To enter the printer's IP address manually, follow the 
instructions below. For Windows Server 2008 R2, to create a Web Services on Devices printer, you must 
be a member of Administrators group.
1 Click The printer that I want isn't listed.
2 Select Add a printer using a TCP/IP address or hostname and click Next.
3 Select Web Services Device from Device type.
4 Enter the printer's IP address in the Hostname or IP address text box and click Next.

• Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, 
perform one of the followings:
- Establish the Internet connection so that Windows Update can scan your computer.
- Add the print driver to your computer in advance.

5 If prompted, install the print driver on your computer. If you are prompted for an administrator 
password or confirmation, type the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Print a test page to verify print installation.
a Click Start → Control Panel → Hardware and Sound → Printers (Start → Devices and 

Printers for Windows Server 2008 R2 and Windows 7).
b Right-click the printer you just created, and then click Properties (Printer properties for 

Windows Server 2008 R2 and Windows 7).
c On the General tab, click Print Test Page. When a test page is printed successfully, 

installation is complete.
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6
Using the Operator Panel Menus

This chapter includes:
• "Understanding the Operator Panel Menus" on page 162
• "Panel Lock Feature" on page 185
• "Changing the Power Saver Mode Settings" on page 187
• "Resetting to Factory Defaults" on page 188
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Understanding the Operator Panel Menus
When your printer is connected to a network and available to a number of users, access to the Admin 
Menu may be restricted. This prevents unauthorized users from using the operator panel to 
inadvertently change the default menu settings that have been set by the administrator. However, you 
can change settings for individual print jobs using the print driver. Print settings selected on the print 
driver have precedence over the default menu settings on the operator panel.
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Report/List
Use Report/List to print various types of reports and lists.

NOTE: 
• A password is required to use the Report/List menu when Panel Lock Set is set to Enable. In this 

case, enter the password you specified, and press the  button.
• The reports and lists are all printed in English.

System Settings
Purpose:
To print a list of information such as the printer name, the serial number, print volume, and network 
settings.

Panel Settings
Purpose:
To print a detailed list of all the settings on the operator panel menus.

Job History
Purpose:
To print a detailed list of the jobs that have been processed. This list contains the last 50 jobs.

Error History
Purpose:
To print a detailed list of paper jams and fatal errors.

Demo Page
Purpose:
To print a test page.

PCL Fonts List
Purpose:
To print a sample of available PCL fonts.

PS Fonts List
Purpose:
To print a sample of available PostScript Level3 Compatible and PDF fonts.
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Meter Readings
Use Meter Readings to check the total number of printed pages.

Admin Menu
Use the Admin Menu to configure a variety of printer features.

NOTE: 
• A password is required to use the Admin Menu when Panel Lock Set is set to Enable. In this case, enter 

the password you specified, and press the  button.

Network
Use the Network option to change the printer settings affecting jobs sent to the printer through the 
network.

• Ethernet
Purpose:
To specify the communication speed and the duplex settings of Ethernet. To make any changes 
effective, turn off the printer and then turn it back on.
Values:

NOTE: 
• This menu item appears only when the printer is connected to a wired network.

• Wi-Fi Status (DocuPrint P255 dw only)
Purpose:
To display the information on the wireless signal strength. No changes can be made on the operator 
panel to improve the status of the wireless connection.
Values:

NOTE: 
• This menu item appears only when the printer is connected to a wireless network.

Auto* Detects the Ethernet settings automatically.

10BASE-T Half Uses 10base-T half-duplex.

10BASE-T Full Uses 10base-T full-duplex.

100BASE-TX Half Uses 100base-TX half-duplex.

100BASE-TX Full Uses 100base-TX full-duplex.
* Factory default menu setting

Good Indicates good signal strength.

Acceptable Indicates marginal signal strength.

Low Indicates insufficient signal strength.

No Reception Indicates that no signal is received.
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• Wi-Fi Setup (DocuPrint P255 dw only)
Purpose:
To configure wireless network settings.
Values:

NOTE: 
• This menu item appears only when the printer is connected to a wireless network.

Manual 
Setup

Enter Network 
(SSID)

Enter a name of up to 32 alphanumeric characters to identify the 
wireless network. As the factory default menu setting, 
wireless_device is specified in advance.

Infrastructure Configures a wireless network with access points.

No 
Security*

Configures a wireless network without security 
encryption.

Mixed Mode 
PSK

Configures a wireless network with the WPA-PSK-
TKIP, WPA-PSK-AES and WPA2-PSK-AES 
encryptions.

PassPhrase 
Entry

Enter a passphrase of 8 to 63 
alphanumeric characters.

WPA-PSK-
TKIP

Configures a wireless network with the WPA-PSK-
TKIP encryption.

PassPhrase 
Entry

Enter a passphrase of 8 to 63 
alphanumeric characters.

WPA2-PSK-
AES

Configures a wireless network with the WPA2-PSK-
AES encryption.

PassPhrase 
Entry

Enter a passphrase of 8 to 63 
alphanumeric characters.

WEP Configures a wireless network with the WEP 
encryption and specify a WEP key of 5 or 13 ASCII 
characters; 10 or 26 hexadecimal characters.

Transmit 
Key

Select the transmit key from 
Auto, WEP Key 1, WEP Key 2, 
WEP Key 3, and WEP Key 4.

Ad-hoc Configures a wireless network without access points.

No 
Security*

Configures a wireless network without security 
encryption.

WEP Configures a wireless network with the WEP 
encryption and specify a WEP key of 5 or 13 ASCII 
characters; 10 or 26 hexadecimal characters.

Transmit 
Key

Select the transmit key from WEP 
Key 1, WEP Key 2, WEP Key 3, 
and WEP Key 4.

* Factory default menu setting
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• WPS Setup (DocuPrint P255 dw only)

NOTE: 
• This menu item appears only when the printer is connected to a wireless network.

• Reset Wi-Fi (DocuPrint P255 dw only)
Purpose:
To initialize wireless network settings. Enabling this feature and rebooting the printer will reset all the 
wireless settings to their factory default settings.
Values:

NOTE: 
• This menu item appears only when the printer is connected to a wireless network.

• TCP/IP
Purpose:
To configure TCP/IP settings. To make any changes effective, turn off the printer and then turn it back 
on.
Values:

NOTE: 
• To configure the IPv6 settings, use the CentreWare Internet Services.

Push 
Button 
Control

PBC Start Cancel* Disables the PBC method for the WPS encryption.

Start Enables the PBC method for the WPS encryption.

PIN Code Start 
Configuration

Starts configuring wireless network settings using the PIN code 
assigned automatically by the printer.

Print PIN Code Prints the PIN code to be entered on the computer for the WPS 
encryption setup.

* Factory default menu setting

No* Does not reset the wireless setting.

Yes Resets the wireless setting.
* Factory default menu setting

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Uses IPv4 to set the IP address.

IPv4 Get IP 
Address

DHCP/AutoIP* Automatically sets the IP address.

BOOTP Uses BOOTP to set the IP address.

RARP Uses RARP to set the IP address.

DHCP Uses DHCP to set the IP address.

Panel Enter the IP address on the operator panel.

IP Address Enter the IP address allocated to the printer.

Subnet Mask Enter the subnet mask.

Gateway Address Enter the gateway address.
* Factory default menu setting
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• Protocol
Purpose:
To enable or disable each protocol. To make any changes effective, turn off the printer and then turn it 
back on.
Values:

• IP Filter
NOTE: 
• The IP Filter feature is available only when Protocol is set to LPD or Port 9100.

Purpose:
To block data received from certain IP addresses through the network. You can set up to five IP 
addresses. To make any changes effective, turn off the printer and then turn it back on.
Values:

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable* Enables the LPD port.

Port 9100 Disable Disables the Port 9100 port.

Enable* Enables the Port 9100 port.

WSD** Disable Disables the Web Services on Devices port.

Enable* Enables the Web Services on Devices port.

SNMP Disable Disables the Simple Network Management Protocol (SNMP) 
UDP port.

Enable* Enables the SNMP UDP port.

Status Messenger Disable Disables the Status Messenger feature.

Enable* Enables the Status Messenger feature.

CentreWare IS Disable Disables an access to the CentreWare Internet Services 
embedded in the printer.

Enable* Enables an access to the CentreWare Internet Services 
embedded in the printer.

Bonjour(mDNS) Disable Disables the Bonjour (mDNS).

Enable* Enables the Bonjour (mDNS).
* Factory default menu setting
** WSD stands for Web Services on Devices.

No.n/Address (n is 1 - 5.) Sets the IP address for Filter n.

No.n/Mask (n is 1 - 5.) Sets the address mask for Filter n.

No.n/Mode (n 
is 1 - 5.)

Off* Disables the IP Filter feature for Filter n.

Reject Rejects an access from the specified IP address.

Accept Accepts an access from the specified IP address.
* Factory default menu setting
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• Initialize NVM
Purpose:
To initialize wired network data stored in Non-Volatile Memory (NVM). Enabling this feature and 
rebooting the printer will reset all the wired network settings to their factory default values.
Values:

• PS Data Format
Purpose:
To set the PS data communications protocol. To make any changes effective, turn off the printer and 
then turn it back on.
Values:

System Settings
Use the System Settings menu to configure a variety of printer features. 

• Power Saving Timer
Purpose:
To specify a time period before the printer enter each power saver mode.
Values:

Select 1min (default) for Low Power Timer if your printer shares an electrical circuit with your room 
lights and you notice them flickering. Otherwise, select a high value to keep your printer available for 
frequent use with the minimum warm-up time.
The printer automatically exits a power saver mode when it receives a print job from a computer. 
Alternatively, you can manually bring it back to the ready-to-print state by pressing the  (Energy 
Saver) button. Whether the printer is in Low Power or Sleep mode, it will take about 25 seconds for 
the printer to resume the ready-to-print state.

Yes Initializes the wired network data stored in NVM.

No* Does not initialize the wired network data stored in NVM.
* Factory default menu setting

Auto* Sets the PS data communications protocol automatically.

Standard Sets the PS data communications protocol to Standard.

BCP Sets the PS data communications protocol to BCP.

TBCP Sets the PS data communications protocol to TBCP.
* Factory default menu setting

Low Power 
Timer

1min* By default, the printer enters Low Power mode in one minute 
of inactivity after completion of the last job. You can change 
the Low Power Timer setting within a range from 1 to 30 
minutes.

1min - 30min

Sleep Timer 6min* By default, the printer enters Sleep mode in six minutes of 
inactivity starting from the moment it entered Low Power 
mode. You can change the Sleep Timer setting within a 
range from 6 to 11 minutes.

6min - 11min

* Factory default menu setting
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• Auto Reset
Purpose:
To specify a time period before the printer restores the default setting for the current menu item and 
resumes the ready-to-print state when an attempt to change the setting is left unfinished.
Values:

• Fault Timeout
Purpose:
To specify a time period before the printer cancels a job that has halted abnormally. Any job will be 
cancelled when it times out.
Values:

• Job Timeout
Purpose:
To specify a time period that the printer waits to receive data from a computer. Any print job will be 
cancelled when it times out.
Values:

• mm / inch
Purpose:
To specify the measurement unit after the numeric value displayed on the operator panel.
Values:

45sec*

1min

2min

3min

4min

* Factory default menu setting

Off Disables the fault time-out feature.

On 60sec* By default, the printer cancels a job in 60 seconds after the job 
halts abnormally. You can change the setting within a range 
from 3 to 300 seconds.

3sec - 300sec

* Factory default menu setting

Off Disables the job time-out feature.

On 30sec* By default, the printer waits to receive data from a computer 
for 30 seconds. You can change the setting within a range 
from 5 to 300 seconds.

5sec - 300sec

* Factory default menu setting

Millimeters (mm)*

Inches (")

* Factory default menu setting
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• Low Toner Alert Msg
Purpose:
To specify whether to show the alert message when the toner is low.
Values:

Maintenance
Use the Maintenance menu to adjust print settings for each paper type, initialize the Non-Volatile 
Memory (NVM), and change the toner cartridge settings.

• F/W Version
Purpose:
To display the version of the controller.

• Adjust BTR
Purpose:
To specify a voltage of the transfer roller (BTR) for optimum printing of each paper type. To lower the 
voltage, specify a negative value. To increase, specify a positive value.
The default settings may not yield the best output on all paper types. If you see mottles on the print 
output, try increasing the voltage. If you see white spots on the print output, try decreasing the voltage.

NOTE: 
• The print quality depends on the values you select for this menu item.

Values:

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.
* Factory default menu setting

Plain 0*

-3 - 3

Light Card 0*

-3 - 3

Labels 0*

-3 - 3

Envelope 0*

-3 - 3

Recycled 0*

-3 - 3

Postcard 0*

-3 - 3

* Factory default menu setting
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• Adjust Fusing Unit
Purpose:
To specify a temperature of the fusing unit for optimum printing of each paper type. To lower the 
temperature, specify a negative value. To increase, specify a positive value.
The default settings may not yield the best output on all paper types. When the printed paper has 
curled, try lowering the temperature. When the toner does not fuse on the paper properly, try 
increasing the temperature.

NOTE: 
• The print quality depends on the values you select for this menu item.

Values:

• Density Adjustment
Purpose:
To adjust the print density level within the range of -3 to 3. The factory default menu setting is 0.

• Clean Developer
Purpose:
To rotate the developer motor and stir the toner in the toner cartridge.
Values:

Plain 0*

-3 - 3

Light Card 0*

-3 - 3

Labels 0*

-3 - 3

Envelope 0*

-3 - 3

Recycled 0*

-3 - 3

Postcard 0*

-3 - 3

* Factory default menu setting

Yes Stirs the toner in a new toner cartridge.

No* Does not stir the toner in a new toner cartridge.
* Factory default menu setting
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• Toner Refresh
Purpose:
To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in 
a new toner cartridge.
Values:

• Initialize NVM
Purpose:
To initialize the NVM for the printer settings. Enabling this feature and rebooting the printer will reset 
all the printer settings to their factory default values.

See also: 
• "Resetting to Factory Defaults" on page 188

Values:

• Non-Genuine Mode
Purpose:
To use a toner cartridge of another manufacturer.

NOTE: 
• Using a non-genuine toner cartridge may make some printer features unusable, reduce print quality and 

decrease the reliability of your printer. We recommend you use only new Fuji Xerox brand toner cartridges for 
your printer. We do not provide warranty coverage for problems caused by using non-genuine consumables.

• Before you use a toner cartridge of another manufacturer, be sure to restart the printer.

Values:

Black Yes Cleans the toner in the toner cartridge.

No* Does not clean the toner in the toner cartridge.
* Factory default menu setting

System Section Yes Initializes the printer settings.

No* Does not initialize the printer settings.
* Factory default menu setting

Toner Off* Does not use a toner cartridge of another manufacturer.

On Uses a toner cartridge of another manufacturer.
* Factory default menu setting
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• Adjust Altitude
Purpose:
To specify the altitude of the location where the printer is installed. 
The discharge phenomenon for charging the photo conductor varies with barometric pressure. You 
can specify the altitude of the printer location for adjustment.

NOTE: 
• An incorrect altitude adjustment leads to poor printing quality and an incorrect indication of remaining toner. 

Values:

• Machine Life
Purpose:
To specify whether to continue print operations when the printer comes to the end of its service life.
Values:

NOTE: 
• When the printer no longer operates showing the error code 191-310 on the LCD panel, press the  (Back) 

button and the  button at the same time and change the Machine Life setting to Keep Printing. Then, 
you can keep using the printer.

• Although you can keep using the printer after the end of its service life by changing the setting to Keep 
Printing, the printing quality is not guaranteed.

0m* Select the altitude of the location where the printer is installed.

1000m

2000m

3000m

* Factory default menu setting

Stop Printing* Stops print operations at the end of service life.

Keep Printing Continues print operations after the end of service life.
* Factory default menu setting
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Secure Settings
Use the Secure Settings menu to set a password to limit access to the operator panel menus. 
This prevents the printer settings from being changed accidentally.

• Panel Lock
Purpose:
To restrict access to Admin Menu and Report/List with a password.

See also: 
• "Panel Lock Feature" on page 185

Values:

• Software Download
Purpose:
To install or discard the software data downloaded and sent by the connected computer.
Values:

USB Settings
Use the USB Settings menu to change printer settings affecting a USB port.

• Port Status
Purpose:
To enable or disable the USB interface.
Values:

Panel Lock Set Disable* Does not restrict access to Admin Menu and Report/List 
with a password.

Enable Restricts access to Admin Menu and Report/List with a 
password.

Change 
Password**

0000*-9999 Sets or changes the password required to access Admin 
Menu and Report/List.

* Factory default menu setting
** Not displayed when Panel Lock Set is set to Disable.

Disable Discards the downloaded software data to maximize data security.

Enable* Installs the downloaded software data.
* Factory default menu setting

Disable Disables the USB interface.

Enable* Enables the USB interface.
* Factory default menu setting
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• PS Data Format
Purpose:
To set the PS data communications protocol. To make any changes effective, turn off the printer and 
then turn it back on.
Values:

PCL Settings
Use the PCL Settings menu to change printer settings that only affect jobs using the PCL emulation 
printer language.

• Paper Size
Purpose:
To specify the default paper size.
Values:

Auto* Sets the PS data communications protocol automatically.

Standard Sets the PS data communications protocol to Standard.

BCP Sets the PS data communications protocol to BCP.

TBCP Sets the PS data communications protocol to TBCP.
* Factory default menu setting

A4 - 210x297*

A5 - 148x210

B5 - 182x257

Letter - 8.5x11

Folio - 8.5x13

Legal - 8.5x14

Executive

Statement

#10Env - 4.125x9.5

Monarch Env.

Monarch Env.L

DL Env - 110x220

DL Env L

C5 Env - 162x229

148 x 100mm

148 x 200mm

Env Yougata2

Env Yougata2L

Env Yougata3

Env Yougata3L

Env Yougata4

Env Yougata6
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• Image Orientation
Purpose:
To specify how text and graphics are oriented on the page.
Values:

• 2 Sided Options
Purpose:
To specify whether to print on either side of paper.
Values:

Env Younaga3

Env Nagagata3

Env Nagagata4

Env Kakugata3

New 
Custom 
Size

Portrait(Y) 297mm*/11.7inc
h*

Specifies the length of the custom size paper. 
Which factory default menu setting displays 
depends on the value selected for mm / inch 
under the System Settings menu. See "mm 
/ inch" on page 169 for more information.

127mm - 
355mm/5.0inch 
- 14.0inch

Landscape(X) 210mm*/8.3inch
*

Specifies the width of the custom size paper. 
Which factory default menu setting displays 
depends on the value selected for mm / inch 
under the System Settings menu. See "mm 
/ inch" on page 169 for more information.

77mm - 
215mm/3.0inch 
- 8.5inch

* Factory default menu setting.

Portrait* Prints text and graphics parallel to the short edge of the paper.

Landscape Prints text and graphics parallel to the long edge of the paper.
* Factory default menu setting

2 Sided Print Off* Does not print on either side of paper.

On Prints on either side of paper.

Binding Edge Flip Long 
Edge*

Prints on either side of paper to be bound on the long edge.

Flip Short 
Edge

Prints on either side of paper to be bound on the short edge.

* Factory default menu setting
176 Using the Operator Panel Menus



• Font
Purpose:
To select the default font from the fonts installed on the printer.
Values:

Courier* AlbertusMd ITCBookmanDb

CGTimes AlbertusXb ITCBookmanLtIt

CGTimesBd Arial ITCBookmanDbIt

CGTimesIt ArialBd NwCentSchlbkRmn

CGTimesBdIt ArialIt NwCentSchlbkBd

CGOmega ArialBdIt NwCentSchlbkIt

CGOmegaBd TimesNew NwCentSchlbkBdIt

CGOmegaIt TimesNewBd Times

CGOmegaBdIt TimesNewIt TimesBd

Coronet TimesNewBdIt TimesIt

ClarendonCd Helvetica TimesBdIt

UniversMd HelveticaBd ZapfChanceryMdIt

UniversBd HelveticaOb Symbol

UniversMdIt HelveticaBdOb SymbolPS

UniversBdIt HelveticaNr Wingdings

UniversMdCd HelveticaNrBd ZapfDingbats

UniversBdCd HelveticaNrOb CourierBd

UniversMdCdIt HelveticaNrBdOb CourierIt

UniversBdCdIt PalatinoRmn CourierBdIt

AntiqueOlv PalatinoBd LetterGothic

AntiqueOlvBd PalatinoIt LetterGothicBd

AntiqueOlvIt PalatinoBdIt LetterGothicIt

GarmondAntiqua ITCAvantGardBk CourierPS

GarmondHlb ITCAvantGardDb CourierPSBd

GarmondKrsv ITCAvantGardBkOb CourierPSOb

GarmondKrsvHlb ITCAvantGardDbOb CourierPSBdOb

Marigold ITCBookmanLt

* Factory default menu setting
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• Symbol Set
Purpose:
To specify a symbol set for the specified font.
Values:

• Font Size
Purpose:
To specify the font size for scalable typographic fonts, within a range from 4.00 to 50.00. The default 
is 12.00.
Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an 
inch.

NOTE: 
• The Font Size menu item only appears for typographic fonts.

• Font Pitch
Purpose:
To specify the font pitch for scalable mono spaced fonts, within a range from 6.00 to 24.00. The 
default is 10.00.
Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For 
nonscheduled mono spaced fonts, the pitch is displayed, but cannot be changed.

NOTE: 
• The Font Pitch menu item only appears for fixed or mono spaced font.

PC-8* PS MATH WINGDINGS

PC-8 DN PI FONT DNGBTSMS

PC-850 LEGAL ISO-L6

PC-852 ISO-4 PC-1004

PC-8 TK ISO-6 PC-775

WIN L1 ISO-11 WINBALT

WIN L2 ISO-15 UCS-2

WIN L5 ISO-17 ROMAN-8

DESKTOP ISO-21 ROMANEXT

MC TEXT ISO-60 ISO-L1

PS TEXT ISO-69 ISO-L2

MS PUB WIN 3.0 ISO-L5

MATH-8 SYMBOL

* Factory default menu setting
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• Form Line
Purpose:
To set the number of lines in a page.
Values:

NOTE: 
• The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and 

Image Orientation settings. Make sure that the Form Line and Image Orientation settings are 
correct before changing the Form Line setting.

• Quantity
Purpose:
To set the default print quantity, within a range from 1 to 999. The default is 1. (Set the number of 
copies required for a specific job on the print driver. Values selected on the print driver always override 
values selected on the operator panel.)

• Image Enhancement
Purpose:
To specify whether to enable the Image Enhancement feature which makes the boundary line 
between black and white smoother to decrease jagged edges and enhance the visual appearance.
Values:

• Draft Mode
Purpose:
To save toner by printing in the draft mode. The print quality is reduced when you print in the draft 
mode.
Values:

64* Select the value in increments of 1.

5-128

* Factory default menu setting

Off* Disables the Image Enhancement feature.

On Enables the Image Enhancement feature.
* Factory default menu setting

Disable* Does not print in the draft mode.

Enable Prints in the draft mode.
* Factory default menu setting
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• Line Termination
Purpose:
To add the line termination commands.
Values:

PS Settings
Use the PS Settings menu to change printer settings that only affect jobs using the PostScript 
Level3 Compatible printer language.

• PS Error Report
Purpose:
To specify whether to print the description of errors concerning the PostScript Level3 Compatible 
printer language.
Values:

• PS Job Timeout
Purpose:
To specify the runtime of a single job using the PostScript Level3 Compatible printer language.
Values:

Off* The line termination command is not added.

CR=CR, LF=LF, FF=FF

Carriage Return The CR command is added.

CR=CR, LF=CR-LF, FF=CR-FF

Line Feed The LF command is added.

CR=CR-LF, LF=LF, FF=FF

CR + LF The CR and LF commands are added.

CR=CR-LF, LF=CR-LF, FF=CR-FF
* Factory default menu setting

Off Dose not print the PS error report.

On* Prints the PS error report.
* Factory default menu setting

Off* Does not set the runtime of a PS job.

On 1min Sets the runtime of a PS job.

1min - 900min

* Factory default menu setting
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PDF Settings
Use the PDF Settings menu to change printer settings that only affect the PDF jobs.

• Quantity
Purpose:
To specify the number of copies to print.
Values:

• 2 Sided Options
Purpose:
To specify whether to print on either side of paper.
Values:

• Print Mode
Purpose:
To specify the print mode.
Values:

• PDF Password
Purpose:
To specify a password for printing secure PDF files.
Values:

1* Select a value in increments of 1.

1 - 999

* Factory default menu setting

2 Sided Print Off* Does not print on either side of paper.

On Prints on either side of paper.

Binding Edge Flip Long 
Edge*

Prints on either side of paper to be bound on the long edge.

Flip Short 
Edge

Prints on either side of paper to be bound on the short edge.

* Factory default menu setting

Normal* For documents with normal sized characters.

High Quality For documents with small characters or thin lines, or documents 
printed using a dot-matrix printer.

* Factory default menu setting

XXXXX Enter a password of up to 32 alphanumeric characters for printing 
secure PDF files.
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• Output Size
Purpose:
To specify the output paper size for PDF files.
Values:

• Layout
Purpose:
To specify the output layout.
Values:

Tray Settings
Use the Tray Settings option to set the paper size and type of paper loaded in the paper tray.

Tray
Purpose:
To specify the paper loaded in the paper tray.

A4 - 210x297*

Auto

Letter - 8.5x11

* Factory default menu setting

Auto %*

4 Pages Up

2 Pages Up

100% (No Zoom)

* Factory default menu setting
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Values:

Paper Size A4 - 210x297*

A5 - 148x210

B5 - 182x257

Letter - 8.5x11

Folio - 8.5x13

Legal - 8.5x14

Executive

Statement

#10Env - 4.125x9.5

Monarch Env.

Monarch Env.L

DL Env - 110x220

DL Env L

C5 Env - 162x229

148 x 100mm

148 x 200mm

Env Yougata2

Env Yougata2L

Env Yougata3

Env Yougata3L

Env Yougata4

Env Yougata6

Env Younaga3

Env Nagagata3

Env Nagagata4

Env Kakugata3

New 
Custom 
Size

Portrait(Y) 297mm*/11.7inch* Specifies the length of the 
custom size paper. Which 
factory default menu 
setting displays depends 
on the value selected for 
mm / inch under the 
System Settings 
menu. See "mm / inch" on 
page 169 for more 
information.

127mm - 
355mm/5.0inch - 
14.0inch

Landscape(X) 210mm*/8.3inch* Specifies the width of the 
custom size paper. Which 
factory default menu 
setting displays depends 
on the value selected for 
mm / inch under the 
System Settings 
menu. See "mm / inch" on 
page 169 for more 
information.

77mm - 
215mm/3.0inch - 
8.5inch
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NOTE: 
• For details on the supported paper sizes, see "Usable Print Media" on page 119.

Paper Type Plain*

Light Card

Labels

Envelope

Recycled

Postcard

* Factory default menu setting
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Panel Lock Feature
This feature prevents unauthorized users from changing the settings on the operator panel made by 
the administrator. However, you can modify the settings for individual print jobs using the print driver.
This section includes:

• "Enabling the Panel Lock Feature" on page 185
• "Disabling the Panel Lock Feature" on page 186

Enabling the Panel Lock Feature
1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button.

5 Select Panel Lock Set, and then press the  button.

6 Select Enable, and then press the  button.

7 If necessary, select Change Password, and then press the  button.

8 Enter a new password, and then press the  button.

NOTE: 
• The factory-default panel password is 0000.

NOTE: 
• If you forget your password, turn off the printer. Then, while holding the  (Menu) button, turn on the printer. 

Continue to hold the  (Menu) button until the LCD panel shows Ready to Print.
• If you want to change the password while Panel Lock Set is Enable, perform steps 1 and 2. Enter the 

current password, and then press the  button. Perform steps 3 and 4. Select Change Password, and 
then press the  button. Enter a new password, and then press the  button. This will change the 
password.
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Disabling the Panel Lock Feature
1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Enter the password, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Panel Lock, and then press the  button.

6 Select Panel Lock Set, and then press the  button.

7 Select Disable, and then press the  button.

NOTE: 
• The password is reset to 0000 when the setting for Panel Lock Set is changed from Enable to Disable.
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Changing the Power Saver Mode Settings
The printer enters a power saver mode after the specified time period of inactivity. You can set Power 
Saving Timer to place the printer in either of the power saver modes.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Power Saving Timer, and then press the  button.

5 Select Low Power Timer or Sleep Timer, and then press the  button.

6 Press the  or  button to select the desired value, and then press the  button.
You can select from 1 - 30 minutes for Low Power Timer or 6 - 11 minutes for Sleep Timer.
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Resetting to Factory Defaults
Enabling the Initialize NVM feature and rebooting the printer will reset all the printer settings to their 
factory default menu settings.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance, and then press the  button.

4 Select Initialize NVM, and then press the  button.

5 Select System Section to initialize the printer settings, and then press the  button.

6 Select Yes, and then press the  button.
The printer restarts automatically with the factory default menu settings.
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7
Troubleshooting

This chapter includes:
• "Clearing Jams" on page 190
• "Basic Printer Problems" on page 203
• "Display Problems" on page 204
• "Printing Problems" on page 205
• "Print Quality Problems" on page 207
• "Other Problems" on page 217
• "Understanding Printer Messages" on page 218
• "Contacting Service" on page 221
• "Getting Help" on page 222
• "Enabling Non-Genuine Mode" on page 224
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Clearing Jams
Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 116
• "Supported Print Media" on page 118

NOTE: 
• Before buying large quantities of any print media, it is recommended that you try a sample first.

This section includes:
• "Avoiding Jams" on page 191
• "Identifying the Location of Paper Jams" on page 192
• "Clearing Paper Jams From the Front of the Printer" on page 193
• "Clearing Paper Jams From the Rear of the Printer" on page 198
• "Clearing Paper Jams From the Center Output Tray" on page 200
• "Jam Problems" on page 202

WARNING:
• If you cannot remove the paper jam by doing the procedures in the manual, do not try to forcibly 

remove the jam. Doing so may cause injuries. Contact your local Fuji Xerox representative.
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Avoiding Jams
• Use only recommended print media.
• See "Loading Print Media in the Paper Tray" on page 126 and "Loading Print Media in the Priority 

Sheet Inserter (PSI)" on page 134 to load print media properly.
• Do not load print media before turning on the printer.
• Do not overload the print media sources.
• Do not load wrinkled, creased, damp, or curled print media.
• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try 

feeding one sheet at a time through the paper tray or the Priority Sheet Inserter (PSI).
• Do not use print media that you have cut or trimmed.
• Do not mix print media sizes, weights, or types in the same print media source.
• Ensure that the recommended print surface is face up when you load print media in the paper 

tray or the Priority Sheet Inserter (PSI).
• Keep print media stored in an acceptable environment.
• Do not remove the paper tray cover while printing is in progress.
• Ensure that all cables that connect to the printer are correctly attached.
• Overtightening the guides may cause jams.

See also: 
• "About Print Media" on page 116 
• "Supported Print Media" on page 118
• "Print Media Storage Guidelines" on page 117
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Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:
• Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped 

around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the 
product immediately and contact your local Fuji Xerox representative.

1 Center Output Tray

2 OPC Drum

3 Levers

4 Rear Cover

5 Front Cover

6 Paper Tray

7 Priority Sheet Inserter (PSI)

1
3

4

5

67

2
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Clearing Paper Jams From the Front of the Printer
This section includes:

• "Clearing Paper Jams From the Paper Tray" on page 193
• "Clearing Paper Jams From the Priority Sheet Inserter (PSI)" on page 196

Clearing Paper Jams From the Paper Tray
IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.
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3 Pull the paper tray out of the printer carefully. Hold the tray with both hands, lift the front slightly, 
and remove it from the printer.

4 Remove all the jammed and/or creased paper from the tray.

5 Pull the jammed paper out carefully to avoid tearing it.

6 Lower the levers to the original position.
194 Troubleshooting



7 Close the rear cover.

8 Insert the paper tray into the printer, and push until it clicks into place.
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Clearing Paper Jams From the Priority Sheet Inserter (PSI)
IMPORTANT: 
• Do not put excessive force on the front cover when removing the jammed paper. Doing so could damage the 

cover.
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Pull the jammed paper out carefully to avoid tearing it.
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4 Lower the levers to the original position.

5 Close the rear cover.
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Clearing Paper Jams From the Rear of the Printer
IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.
• Protect the OPC drum against bright light. If the rear cover is left open for more than three minutes, print 

quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove the jammed paper from the rear of the printer.
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4 Lower the levers to the original position.

5 Close the rear cover.

If the error is not resolved, there may be a piece of paper remaining inside the printer. Use the 
following procedure to clear the jam.

6 Load a print media on the Paper Tray or PSI if there is no print media.

7 Press and hold  (Cancel Job) button for more than three seconds.
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Clearing Paper Jams From the Center Output Tray
IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.
• Protect the OPC drum against bright light. If the rear cover is left open for more than three minutes, print 

quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove the jammed paper from the rear of the printer. If no paper is found in the paper path, 
then remove it from the center output tray.
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4 Lower the levers to the original position.

5 Close the rear cover.

If the error is not resolved, there may be a piece of paper remaining inside the printer. Use the 
following procedure to clear the jam.

6 Load a print media on the Paper Tray or PSI if there is no print media.

7 Press and hold  (Cancel Job) button for more than three seconds.
Troubleshooting 201



Jam Problems
This section includes:

• "Misfeed Jam" on page 202
• "Multi-feed Jam" on page 202

Misfeed Jam

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Multi-feed Jam

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
Print media misfeeds occur. Remove the paper from the Priority Sheet Inserter (PSI), and then 

ensure that the paper is properly inserted in the paper tray.

Depending on the print media you use, take any of the following 
actions:
• For thick paper, use the one that is 163 gsm or less.
• For postcard, the one up to 190 gsm is available.
• For thin paper, use the one that is 60 gsm or more.
• For the envelope, ensure that it is properly loaded in the paper tray 

as instructed in "Loading Envelopes in the Paper Tray" on 
page 130.

If the envelope is deformed, correct it or use another envelope.

If performing manual duplex (2-sided) printing, ensure that the print 
media is not curled.

Fan the print media.

If the print media is damp, turn over the print media.

If the problem continues, use print media that is not damp. 

Problem Action
Print media multiple feeds occur. Remove the paper from the Priority Sheet Inserter (PSI), and then 

ensure that the paper is properly loaded in the paper tray.

If the print media is damp, use print media that is not damp.

Fan the print media. 
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Basic Printer Problems
Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the 
following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.
• The printer is turned on.
• The electrical outlet is not turned off at any switch or breaker.
• Other electrical equipment plugged into the outlet is working.
• When the DocuPrint P255 dw model is connected to a wireless network, an Ethernet cable 

should be unplugged from the printer.
If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, 
and then turn on the printer. This often fixes the problem.
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Display Problems

Problem Action
After the printer is turned on, the 

 (Ready) LED is not lit.
Turn off the printer, wait for 10 seconds, and turn on the printer.

Menu settings changed from the 
operator panel have no effect.

Settings in the software program, the print driver, or the printer utilities 
have precedence over the settings made on the operator panel.

Change the menu settings from the print driver, the printer utilities, or 
the software program instead of the operator panel.
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Printing Problems

Problem Action
Job did not print or incorrect 
characters printed.

Ensure that the  (Ready) LED is lit.

Ensure that print media is loaded in the printer.

Verify that you are using the correct print driver.

Ensure that you are using the correct Ethernet or USB cable and that 
it is securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the interface of your printer from Admin Menu.

Determine the host interface you are using. Print the System Settings 
page to verify that the current interface settings are correct. Refer to 
"Printing the System Settings Page" on page 156 for details on how to 
print the System Settings page.

Print media misfeeds or multiple 
feeds occur.

Ensure that the print media you are using meets the specifications for 
your printer. 

See also: 
• "Usable Print Media" on page 119

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the paper width guides and length guide are adjusted 
correctly.

Do not overfill the print media sources.

Do not force print media into the Priority Sheet Inserter (PSI) or the 
paper tray when you load it. Otherwise, it may skew or buckle.

Ensure that the print media is not curled.

Load print media with the recommended print surface facing in the 
correct direction.

See also: 
• "Loading Print Media" on page 125

Turn the print media over or around and try printing again to see if 
feeding improves.

Do not mix print media types.

Do not mix print media sizes.

Remove the top and bottom curled sheets of a ream before loading 
the print media.

Load a print media source only when it is empty.

The envelope is creased after 
printing.

Ensure that the envelope is loaded in the paper tray as instructed in 
"Loading Envelopes in the Paper Tray" on page 130.

Page breaks in unexpected 
places.

Increase the value for Job Time-Out in the System Settings menu, 
that is on the Printer Maintenance tab in the Printer Setting Utility.

Increase the time-out value in the Protocol Settings menu on the 
CentreWare Internet Services.
Troubleshooting 205



Print media does not stack neatly 
in the center output tray.

Turn the print media stack over in the Priority Sheet Inserter (PSI) and 
the paper tray.

Printer does not duplex pages. Select Flip on Short Edge or Flip on Long Edge from the Duplex 
menu on the Paper/Output tab of the print driver.

Problem Action
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Print Quality Problems
This section includes:

• "The Output Is Too Light" on page 208
• "Toner Smears or Print Comes Off/Stain on Back Side" on page 209
• "Random Spots/Blurred Images" on page 210
• "The Entire Output Is Blank" on page 210
• "Streaks Appear on the Output" on page 211
• "Mottle" on page 211
• "Ghosting" on page 212
• "Fog" on page 213
• "Bead-Carry-Out (BCO)" on page 213
• "Auger Mark" on page 214
• "Wrinkled/Stained Paper" on page 215
• "The Top Margin Is Incorrect" on page 216
• "Protrudent/Bumpy Paper" on page 216

NOTE: 
• In this section, some procedures use the Printer Setting Utility or the SimpleMonitor. Some procedures that 

use the Printer Setting Utility can also be performed using the operator panel.

See also: 
• "Understanding the Operator Panel Menus" on page 162
• "Printer Setting Utility (Windows Only)" on page 42
• "SimpleMonitor (Windows Only)" on page 43
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The Output Is Too Light

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
The output is too light. The toner cartridge may be low or need to be replaced. Confirm the 

amount of toner in the toner cartridge. 
1 Check the toner level on the Consumables tab of the Printer 

Status window of the SimpleMonitor.
2 Replace the toner cartridge as needed.

Verify that the print media is dry and the correct print media is used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 119

Try changing the Paper Type setting on the print driver.
1 On the Paper/Output tab for Printing Preferences of the print 

driver, change the Paper Type setting.

Disable Toner Saving Mode on the print driver.
1 On the Graphics tab in Printing Preferences of the print driver, 

ensure that the Toner Saving Mode check box is not selected.
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Toner Smears or Print Comes Off/Stain on Back Side

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
Toner smears or print comes off.

The output has stain on the back 
side.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change Plain to 
Lightweight Cardstock.
1 On the Paper/Output tab for Printing Preferences of the print 

driver, change the Paper Type setting.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 119

Adjust the temperature of the fusing unit.
1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 

the Printer Maintenance tab.
2 Adjust the fixing temperature by turning up the value for your 

printing media.
3 Click the Apply New Settings button.
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Random Spots/Blurred Images

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

The Entire Output Is Blank

If this trouble happens, contact our local representative office or authorized dealer.

Problem Action
The printed result has random 
spots or is blurred.

Ensure that the toner cartridge is installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 232

If you use a non-genuine brand toner cartridge, install a genuine 
brand toner cartridge.

Clean up the fusing unit.
1 Load one sheet of paper in the paper tray, and then print a solid 

image all over paper.
2 Load the printed sheet with the print surface facing down, and then 

print a blank sheet of paper.
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Streaks Appear on the Output

If this trouble happens, contact our local representative office or authorized dealer.

Mottle

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
The printed result has mottled 
appearance.

Adjust the transfer bias.
1 Launch the Printer Setting Utility, click Adjust BTR on the Printer 

Maintenance tab.
2 Adjust the setting for the type of print media being used.
3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Ghosting

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
The printed result has ghosting. The print media surface may be uneven. Try changing the Paper 

Type setting in the print driver. For example, change Plain to 
Lightweight Cardstock.
1 On the Paper/Output tab for Printing Preferences of the print 

driver, change the Paper Type setting.

Adjust the transfer bias.
1 Launch the Printer Setting Utility, click Adjust BTR on the Printer 

Maintenance tab.
2 Adjust the setting for the type of print media being used.
3 Click the Apply New Settings button.

Adjust the temperature of the fusing unit.
1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 

the Printer Maintenance tab.
2 Adjust the fixing temperature by turning up the value for your 

printing media.
3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Fog

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Bead-Carry-Out (BCO)

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
The printed result is foggy. When the whole is printed light, contact our local representative office 

or authorized dealer.

When the printed page is partly light, start Clean Developer.
1 Launch the Printer Setting Utility, and click Clean Developer on 

the Diagnosis tab.
2 Click the Start button.

Problem Action
Bead-Carry-Out (BCO) is 
happening.

If the printer is installed in a high altitude location, set the altitude of 
the location.
1 Launch the Printer Setting Utility, and click Adjust Altitude on the 

Printer Maintenance tab.
2 Select the value close to the altitude of the location where the 

printer is installed.
3 Click the Apply New Settings button.
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Auger Mark

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
The printed result has auger 
mark.

The toner cartridge may be low or need to be replaced. Confirm the 
amount of toner in the toner cartridge.
1 Check the toner level on the Consumables tab of the Printer 

Status window of the SimpleMonitor.
2 Replace the toner cartridge as needed.

Start Clean Developer.
1 Launch the Printer Setting Utility, and click Clean Developer on 

the Diagnosis tab.
2 Click the Start button.
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Wrinkled/Stained Paper

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
The output is wrinkled.

The output is stained.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

If excessive wrinkles occur, use paper or other media from a new 
package.

See also: 
• "Usable Print Media" on page 119
• "About Print Media" on page 116

If you use the envelope, check whether the crease is within 30 mm of 
the four edges of the envelope.

If the crease is within 30 mm of the four edges of the envelope, this is 
considered normal. Your printer is not at fault.

If not, check if the printer supports your envelope type, and then 
check if you loaded the envelope in the correct orientation. For more 
information, see "Loading Print Media in the Paper Tray" on page 126 
or "Loading Print Media in the Priority Sheet Inserter (PSI)" on 
page 134.
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The Top Margin Is Incorrect

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Protrudent/Bumpy Paper

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact our local 

representative office or authorized dealer.

Problem Action
The top margin is incorrect. Ensure that the margins are set correctly on the application being 

used.

Problem Action
Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.
1 Load one sheet of paper in the paper tray, and then print a solid 

image all over paper.
2 Load the printed sheet with the print surface facing down, and then 

print a blank sheet of paper.
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Other Problems

Problem Action
Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in 
winter. This also occurs when the printer is operating in a location 
where relative humidity reaches 85% or more. Adjust the humidity or 
relocate the printer to an appropriate environment.
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Understanding Printer Messages
The printer’s LCD panel displays a message describing the current state of the printer or indicates a 
possible printer problem you must resolve. This section describes error codes included in the 
messages, their meanings, and how to clear the messages.

IMPORTANT: 
• When an error message is displayed, the print data remaining on the printer and the information accumulated 

in the memory of the printer are not secured.

Error Code What You Can Do
010-397 Turn off the printer, and then on. If this does not solve the problem, contact our local 

representative office or authorized dealer.

See also: 
• "Online Services" on page 247

016-501

016-502

016-719 Press the  button to cancel the current job. Retry when the printer does not process 
any job.

016-744 Press the  button to clear the message. If this does not solve the problem, contact our 
local representative office or authorized dealer.

See also: 
• "Online Services" on page 247

016-745

016-753 Press the  button to cancel the current job. Retry when the printer does not process 
any job.016-755

016-920 Press the  button to clear the message. Check the wireless settings for the access 
point and the printer.

018-338 Turn off the printer, and then on. If this does not solve the problem, contact our local 
representative office or authorized dealer.

See also: 
• "Online Services" on page 247

024-340

024-360

024-371

024-963 Load the specified paper and press the  button to clear the message. Follow the on-
screen instruction if one appears.

See also: 
• "Loading Print Media in the Paper Tray" on page 126
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134

041-340 Turn off the printer, and then on. If this does not solve the problem, contact our local 
representative office or authorized dealer.

See also: 
• "Online Services" on page 247

042-358

061-370

091-402 The service life of your printer is coming to an end and the printer will soon stop run-
ning. If you want to keep using the printer, change the Machine Life setting to Keep 
Printing. However, continuous use of the printer will degrade the print quality.

See also: 
• "Machine Life" on page 173
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NOTE: 
• As for the following message, which does not include an error code, refer to the table below for the solution.

091-441 The printer has exceeded its service life or the settings have been changed to continue 
using it. The quality of printouts will degrade if the printer continues to be used.

See also: 
• "Machine Life" on page 173

092-651 Turn off the printer, and then on. If this does not solve the problem, contact our local 
representative office or authorized dealer.

See also: 
• "Online Services" on page 247

092-661

116-314 Turn off the printer, and then on. If this does not solve the problem, contact our local 
representative office or authorized dealer.

See also: 
• "Online Services" on page 247

116-355

116-720 Press the  button to cancel the current job. Retry when the printer does not process 
any job.

124-333 Turn off the printer, and then on. If this does not solve the problem, contact our local 
representative office or authorized dealer.

See also: 
• "Online Services" on page 247

191-310 Although the service life of your printer has been over and the printer stopped running, 
you can still use the printer by pressing the  (Back) button and the  button at the 
same time. However, continuous use of the printer will degrade the print quality.

See also: 
• "Machine Life" on page 173

191-311 The life of your printer has been over and you can no longer use the printer.

Error Message What You Can Do
Load Paper

Press OK

AAAA

BBBB

AAAAA:  Paper size

BBBBB:  Paper Type

Check and clear the paper path, load the paper, and then press the 
 button to clear the message.

See also: 
• "Clearing Paper Jams From the Front of the Printer" on page 193

Error Code What You Can Do
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Load Paper

then Press OK

AAAA

BBBB

AAAAA:  Paper size

BBBBB:  Paper Type

Load the specified paper and press the  button to clear the 
message.

See also: 
• "Loading Print Media in the Paper Tray" on page 126
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on 

page 134

Wrong PaperSize:

Reload>Press OK

AAAA

BBBB

AAAAA:  Paper size

BBBBB:  Paper Type

Paper Jam:

Open Rear Cover

>Clear Jam

Open the rear cover and remove the jammed paper.

See also: 
• "Clearing Paper Jams From the Rear of the Printer" on page 198

Jam at Exit

Open Rear Door

and Remove Paper

Paper Jam: Open

Rear Cover>Push

Up Green Lever>

Clear Jam

Rear Cover Open

Close Rear Cover

Close the rear cover.

Toner Low

Replace Soon

Replace the toner cartridge soon.

See also: 
• "Replacing the Toner Cartridge" on page 228

Invalid Toner Replace the toner cartridge with a supported one.

See also: 
• "Replacing the Toner Cartridge" on page 228

Replace

Toner Cartridge

Replace the toner cartridge with a new one. If you do not replace the 
toner cartridge, print quality problems may occur.

See also: 
• "Replacing the Toner Cartridge" on page 228

Insert

Toner Cartridge

Turn off the printer, check if the toner cartridge is installed correctly, 
and then turn on the printer. If this does not solve the problem, contact 
our local representative office or authorized dealer.

See also: 
• "Online Services" on page 247

Error Message What You Can Do
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Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the 
error message on the LCD panel.
You need to know the model of your printer and serial number. See the label on the rear cover of your 
printer.
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Getting Help
This section includes:

• "LCD Panel Messages" on page 222
• "SimpleMonitor Alerts" on page 222
• "Obtaining the Product Information" on page 223

We provide several automatic diagnostic tools to help you produce and maintain print quality.

LCD Panel Messages
The LCD panel provides you with information and troubleshooting help. When an error or warning 
condition occurs, the LCD panel displays a message informing you of the problem. 

See also: 
• "Understanding Printer Messages" on page 218

SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Software Pack CD-ROM. It automatically checks 
the printer status when you send a print job. If the printer is unable to print your job, the SimpleMonitor 
automatically displays an alert on your computer screen to let you know that the printer needs 
attention.
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Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.

NOTE: 
• The communication fee shall be borne by users. 

1 On your print driver's Properties dialog box, click the Configuration tab and then click About.

2 Click Fuji Xerox Web Site. 
Your web browser starts and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 
• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/.
• For the latest information about the print driver features, refer to the Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded 
within the printer) from your computer.
The latest firmware and updating tool can be downloaded from the following URL.
Follow the instructions on the web site and download the correct firmware update.
http://www.fujixeroxprinters.com/ 

NOTE: 
• The communication fee shall be borne by users.
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Enabling Non-Genuine Mode
When toner within the toner cartridge is empty, the Replace Toner Cartridge message appears.
When you want to use the printer in Non-Genuine Mode, enable Non-Genuine Mode and replace the 
toner cartridge.

IMPORTANT: 
• If you use the printer in Non-Genuine Mode, the performance of the printer may not be at its optimum. And 

any problems that may arise from the use of Non-Genuine Mode are not covered by our quality guarantee. 
The continuous use of Non-Genuine Mode can also cause the printer to break down, and any repair charges 
for such break down will be incurred by users.

NOTE: 
• To disable Non-Genuine Mode, select Off for Toner of Non-Genuine Mode on the operator panel or clear 

the check box next to On on the Non-Genuine Mode page of the Printer Maintenance tab of the Printer 
Setting Utility.

This section includes:
• "Using the Operator Panel" on page 224
• "Using the Printer Setting Utility (Windows Only)" on page 225

Using the Operator Panel
NOTE: 
• Before starting the operation described below, confirm that the LCD panel shows Ready to print.

1 Press the  (Menu) button.

2 Select Admin Menu and then press the  button.

3 Select Maintenance and then press the  button.

4 Select Non-Genuine Mode and then press the  button.

5 Select Toner and then press the  button.

6 Select On and then press the  button.

7 Press the  button until the top page is displayed.
The printer switches to Non-Genuine Mode.
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Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 
• The window to select a printer appears in this step when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility starts.

2 Click the Printer Maintenance tab.

3 Select Non-Genuine Mode from the list at the left side of the page.
The Non-Genuine Mode page is displayed.

4 Select the check box next to On, and then click the Apply New Settings button.
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8
Maintenance

This chapter includes:
• "Replacing the Toner Cartridge" on page 228
• "Ordering Supplies" on page 234
• "Storing Consumables" on page 236
• "Managing the Printer" on page 237
• "Conserving Supplies" on page 240
• "Checking Page Counts" on page 241
• "Moving the Printer" on page 242
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Replacing the Toner Cartridge
Genuine toner cartridges are available only through Fuji Xerox.
It is recommended that you use a genuine toner cartridge for your printer. Fuji Xerox does not provide 
warranty coverage for problems caused by using non-genuine consumables.

IMPORTANT: 
• Do not shake the used toner cartridge to avoid spilling of the toner.

This section includes:
• "When to Replace the Toner Cartridge" on page 229
• "Removing the Toner Cartridge" on page 230
• "Installing a Toner Cartridge" on page 232

WARNING:
• Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills.

It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

CAUTION:
• Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of 

children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water and 
consult a physician immediately.

• When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be careful not 
to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes and mouth as well 
as inhalation.

• If toner spills onto your skin or clothing, wash it off with soap and water. 
If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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When to Replace the Toner Cartridge
The printer has one toner cartridge: black (K).
When a toner cartridge reaches its usable life-span, the following messages appear on the LCD panel.

IMPORTANT: 
• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner 

cartridge to catch any toner that may spill.
• Do not reuse old toner cartridges that you remove from the printer. Doing so can impair print quality.
• Do not shake or pound used toner cartridges. The remaining toner may spill.
• We recommend you use up a toner cartridge within one year after you remove it from the packaging.

Message Remaining Page Yield Printer Status and Action
Toner Low

Replace Soon*

Approx. 500 pages The toner cartridge has become low. Prepare a 
new one.

Replace

Toner Cartridge

— The toner cartridge has become empty. Replace 
the old toner cartridge with a new one.

* This warning appears only when a genuine toner cartridge is used (i.e. Non-Genuine Mode is disabled).
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Removing the Toner Cartridge
1 Turn off the printer.

2 Open the front cover.

3 Open the toner access cover.

4 Spread a few sheets of paper on the floor or table where you want to place the removed toner 
cartridge.

5 Turn the toner cartridge counterclockwise to unlock.
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6 Pull the toner cartridge out.

IMPORTANT: 
• Do not touch the shutter of the used toner cartridge.
• Always pull the toner cartridge out slowly so you do not spill any toner.

7 Place the toner cartridge slowly on the sheets of paper you spread in step 4.
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Installing a Toner Cartridge
1 Unpack a new toner cartridge and shake it five times to distribute the toner evenly.

NOTE: 
• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Insert the toner cartridge into the cartridge holder, and then turn it clockwise to align to the lock 
mark.

IMPORTANT: 
• Be sure to secure the toner cartridge firmly before printing. Otherwise, it may cause some defects.
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3 Close the toner access cover. Make sure that the cover clicks into place.

4 Close the front cover.

5 Pack the removed toner cartridge in the box in which the installed toner cartridge was packed up.

6 Taking care not to touch any spilled toner, dispose of the sheets of paper you used for toner 
cartridge replacement.
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Ordering Supplies
The toner cartridge needs to be ordered occasionally. The toner cartridge includes installation 
instructions on the box.
This section includes:

• "Consumables" on page 234
• "When to Order a Toner Cartridge" on page 234
• "Recycling Supplies" on page 235

Consumables
IMPORTANT: 
• Use only consumables we recommend. Use of any consumables other than recommended can impair 

machine quality and performance.

IMPORTANT: 
• The number of printable pages are applicable when A4 plain paper SEF ( ) is used and printing is done 

continuously in the print ratio of 5% in image density. Also, it satisfies the public values on the basis of JIS 
X6931 (ISO/IEC 19752). These values are estimates and vary depending on conditions such as the content 
being printed, paper size, paper type, the printer’s operating environment, initializing process done when you 
turn on or off the printer, and adjustments to maintain print quality.

NOTE: 
• The printable number of pages for the starter toner cartridge shipped with the printer is approximately 1,000 

pages on DocuPrint P255 dw and 2,500 pages on DocuPrint P255 d.
• Each toner cartridge includes installation instructions on the box.

When to Order a Toner Cartridge
The LCD panel displays a warning when the toner cartridge nears its replacement time. Verify that you 
have a replacement at hand. It is important to order a toner cartridge when the message first appears 
to avoid interruptions to your printing. The LCD panel displays an error message when the toner 
cartridge must be replaced.
To order a toner cartridge, contact our local representative office or authorized dealer.

IMPORTANT: 
• This printer is designed to provide the most stable performance and print quality when used with the 

recommended toner cartridge. Not using the toner cartridge recommended for this printer degrades the 
performance and printing quality of the printer. You could also incur charges if the printer breaks down. To 
receive customer support and achieve the optimum performance of the printer, be sure to use the 
recommended toner cartridge.

Product Name Product Code Description
Toner Cartridge CT201918 Available for DocuPrint P255 dw and capable of printing 

approximately 2,500 pages.

Toner Cartridge CT201919 2-in-1 package of CT201918

Toner Cartridge CT201920 Available for DocuPrint P255 d and capable of printing 
approximately 2,500 pages.

Toner Cartridge CT201921 2-in-1 package of CT201920
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Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges and drums (photoreceptors) to make recycle parts, recycle materials or energy 
recovery.

• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges. 
Return them to your local Fuji Xerox representative.
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Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables 
in:

• Temperatures greater than 40 °C (140 °F).
• An environment with extreme changes in humidity or temperature.
• Direct sunlight.
• Dusty places.
• A car for a long period of time.
• An environment where corrosive gases are present.
• An environment with salty air.
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Managing the Printer
This section includes:

• "Checking or Managing the Printer with the CentreWare Internet Services" on page 237
• "Checking Printer Status with the SimpleMonitor (Windows Only)" on page 238
• "Checking Printer Status Through E-mail" on page 239

Checking or Managing the Printer with the CentreWare 
Internet Services

When the printer is installed in a TCP/IP environment, you can check printer status and configure 
settings using a web browser on a network computer. You can also use the CentreWare Internet 
Services to check the remaining volume of consumables and the paper loaded in this printer.

NOTE: 
• When using the printer as a local printer, you cannot use the CentreWare Internet Services. For details on 

checking the status of a local printer, refer to "Checking Printer Status with the SimpleMonitor (Windows 
Only)" on page 238.

Starting the CentreWare Internet Services
Use the following procedure to start the CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.
The CentreWare Internet Services appears on your browser.

• Using Online Help
For details regarding the items that you can set on the CentreWare Internet Services, click the Help 
button to display the online Help.
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Checking Printer Status with the SimpleMonitor 
(Windows Only)

The SimpleMonitor is a tool that is installed along with your print driver. It automatically checks the 
printer status when you send a print job. The SimpleMonitor can also check the status of the paper 
tray and remaining amount of toner in the toner cartridge.

Starting the SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Printer 
Selection.
If the SimpleMonitor icon is not displayed on the taskbar, open the SimpleMonitor from the Start 
menu. 
The following procedure uses Microsoft Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → SimpleMonitor-Btype for Asia-Pacific.
The Printer Selection window appears.

2 Click the name of the desired printer from the list.
The Printer Status window appears.

For details on the functions of the SimpleMonitor, refer to the Help of the SimpleMonitor.

See also: 
• "SimpleMonitor (Windows Only)" on page 43
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Checking Printer Status Through E-mail
When connected in a network environment where e-mail exchange is available, the printer can send 
an e-mail report to specified e-mail addresses containing the following information:

• The network settings and the printer status
• The error status which has occurred on the printer

Setting the E-mail Environment
Access the CentreWare Internet Services. On the Properties tab, configure the following settings 
according to your e-mail environment. After configuring the settings on each window, always click 
Apply and then turn off/on the printer to reboot. For details on each item, refer to the Help on the 
CentreWare Internet Services.

Item Item to be configured Description
General Setup > 
StatusMessenger

Recipient's E-mail 
Address

Specify up to two e-mail addresses to which notices 
about changes in printer status or errors are sent.

Notification Items Set the content of the notices to send via e-mail.

Port Status StatusMessenger Select Enabled.

Protocol Settings > 
E-mail

SMTP Server Settings
• Machine's E-mail 

Address
• SMTP Server Address
• SMTP Server Port 

Number

Send Authentication
• E-Mail Send 

Authentication
• Login Name
• Password
• Re-enter Password

POP3 Server Settings
• POP3 Server Address
• POP3 Server Port 

Number
• Login Name
• Password
• Re-enter Password

Select appropriate settings for sending and 
receiving e-mails.
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Conserving Supplies
You can change several settings of your print driver to conserve toner and paper.

Supply Setting Function
Toner cartridge Toner Saving Mode in 

the Graphics tab of the 
print driver

This check box allows the users to select a print mode 
that uses less toner. When this feature is used, the 
image quality will be lower than when it is not used.

Print media Multiple Up in the Layout 
tab of the print driver

The printer prints two or more pages on one side of a 
sheet. The available numbers that each print driver can 
print on one sheet of paper are as follows:
• Microsoft Windows Print Driver: 2, 4, 8, or 16 pages
• Mac OS X Print Driver: 2, 4, 6, 9, or 16 pages

Combined with the Duplex (2-sided) print setting, 
Multiple Up allows you to print up to 32 pages on one 
sheet of paper. (16 images on the front and 16 on the 
back)
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Checking Page Counts
You can print the System Settings page to check the total number of printed pages. The total number 
of printed pages is shown in the Print Volume section, classified by paper sizes.
Single side print (including Multiple Up print) is counted as one job, and 2-sided print (including 
Multiple Up print) is counted as two. During duplex (2-sided) printing, if an error occurs after one side 
is printed properly, it is counted as one.
During duplex (2-sided) printing, a blank page may be inserted automatically depending on the 
settings of the application. In this case, the blank page is counted as one page. If a blank page is 
inserted during duplex (2-sided) printing for odd-number pages and the rear of the last odd-number 
page is left blank, however, this page is excluded from page counting.

NOTE: 
• Refer to "Printing the System Settings Page" on page 156 for details on how to print the System Settings 

page.
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Moving the Printer
IMPORTANT: 
• Printer must be moved or stored top-side up after usage or it may break down.
242 Maintenance



1 Turn off the printer.

2 Disconnect the power cord, interface cable, and any other cables.

3 Remove all paper from the center output tray and close the output tray extension, if open.
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4 Remove the paper tray from the printer.

5 Lift the printer and move it gently.

NOTE: 
• If you move the printer over a long distance, be sure to remove the toner cartridge and pack the printer 

inside a box to avoid spilling of the toner.

6 Place the printer at a new location and replace the paper tray.
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9
Contacting Fuji Xerox
This chapter includes:

• "Technical Support" on page 246
• "Online Services" on page 247
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Technical Support
Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product 
diagnostics, information contained on the Web, and e-mail support. If unsuccessful, to obtain services 
under product warranty, the Customer must notify Fuji Xerox Telephone Support or its authorized 
service representative of the defect before the expiration of the warranty period. Customer will provide 
appropriate assistance to Telephone Support personnel to resolve issues, such as restoration of the 
operating system, software program and drivers to their default configuration and settings, verification 
of functionality of our products, replacement of customer replaceable units, clearing paper misfeeds 
and cleaning the unit and other prescribed routine and preventative maintenance.
If the Customer’s product contains features that enable Fuji Xerox or its authorized service 
representative to diagnose and repair problems with the product remotely, we may request that the 
Customer allow such remote access to the product.
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Online Services
You can find detail Product and Consumable warranty information and activate your warranty by 
registering your details on our web site at http://www.fujixerox.com/support/docuprint/.
Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your 
printer problems. It is an easy-to-use, searchable online Help. To find out more, please visit our online 
support at http://www.fujixerox.com/support/docuprint/.
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